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SOLIDWORKS® 2017 Reference Guide Design Intent, Sketching and Sketch Entities

CHAPTER 4: DESIGN INTENT,
SKETCHING AND SKETCH
ENTITIES

Chapter Objective

Chapter 4 provides a comprehensive understanding of Design Intent, Sketching and the
available Sketch Entities in SOLIDWORKS. On the completion of this chapter, you will
be able to:

e Define and incorporate Design Intent in a:
e Sketch, Feature, Part, Assembly and Drawing document.
e Utilize the available SOLIDWORKS Design Intent tools:

e Comments, Design Binder, ConfigurationManager, Dimensions, Equations,
Design Tables and Features.

e Identify the correct Reference planes:
e 2D and 3D Sketching.
o Insert sketch Reference planes.
e Comprehend the Parent/Child relationship.
e Recognize and address Sketch states:

e Fully Defined, Over Defined, Under Defined, No Solution Found and Invalid
Solution Found.

e Identify and utilize the following Sketch Entities tools:

e Line, Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle,
3 Point Center Rectangle, Parallelogram, Straight Slot, Centerpoint Straight Slot,
3 Point Arc Slot, Centerpoint Arc Slot, Instant3D, Polygon, Circle, Perimeter
Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Conic, Spline, Style Spline, Spline on Surface, Equation Driven Curve,
Point, Centerline, Text, Plane, Route line and Belt/Chain.

e (lassify and utilize the following Block tools:

e Make Block, Edit Block, Insert Block, Add/Remove, Rebuild, Saves Block,
Explode Block and Belt/Chain.

e Recognize and utilize the following Spline tools:
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e Add Tangency Control, Add Curvature Control, Insert Spline Point, Simplify
Spline, Fit Spline, Show Spline Handle, Show Inflection points, Show Minimum

Radius and Show Curvature Combs.

e Reuse an existing 2D Sketch.

Design Intent

What is design intent? All designs are created for a purpose. Design intent is the
intellectual arrangements of features and dimensions of a design. Design intent governs
the relationship between sketches in a feature, features in a part and parts in an assembly.

The SOLIDWORKS definition of design intent is the process in which the model is
developed to accept future modifications. Models behave differently when design

changes occur.

Design for change. Utilize geometry for symmetry, reuse common features, and reuse
common parts. Build change into the following areas that you create: sketch, feature,

part, assembly and drawing.

w1

“¥* When editing or repairing geometric relations, it is considered best practice to edit

the relation vs. deleting it.

Design Intent in a Sketch

Build design intent in a sketch as the profile is created. A
profile is determined from the Sketch Entities. Example:
Rectangle, Circle, Arc, Point, Slot etc. Apply symmetry
into a profile through a sketch centerline, mirror entity and
position about the reference planes and Origin. Always
know the location of the Origin in the sketch.

Build design intent as you sketch with automatic
Geometric relations. Document the decisions made during
the up-front design process. This is very valuable when
you modify the design later.

A rectangle (Center Rectangle Sketch tool) contains
Horizontal, Vertical and Perpendicular
automatic Geometric relations. =

Apply design intent using added uf
Geometric relations if needed. Example: : o
Horizontal, Vertical, Collinear,

Perpendicular, Parallel, Equal etc.
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Example A: Apply design intent to create a square profile.

Sketch a rectangle. Apply the Center Rectangle Sketch tool. 3.00

Note: No construction reference centerline or Midpoint

relation is required with the Center Rectangle tool. Insert S = /,//
dimensions to fully define the sketch. oo Sy
Example B: If you have a hole in a part that must always be | /‘/'%\\ |
16.5mm < from an edge, dimension to the edge rather than e \‘\,\

to another point on the sketch. As the part size is modified, =
the hole location remains 16.5mm < from the edge as
illustrated.

Design Intent in a Feature

Build design intent into a feature by addressing End
Conditions (Blind, Through All, Up to Next, Up to
Vertex, Up to Surface, Offset from Surface, Up to Body
and Mid Plane), symmetry, feature selection, and the
order of feature creation.

Example A: The Extruded Base feature remains symmetric
about the Front Plane. Utilize the Mid Plane End Condition
option in Direction 1. Modify the depth, and the feature
remains symmetric about the Front Plane.

Example B: Create 34 teeth in the model. Do
you create each tooth separately using the
Extruded Cut feature? No.

Create a single tooth and then apply the
Circular Pattern feature. Modify the Circular
Pattern from 32 to 24 teeth.

Design Intent in a Part

Utilize symmetry, feature order and reusing
common features to build design intent into a
part. Example A: Feature order. Is the entire
part symmetric? Feature order affects the part.

Apply the Shell feature before the Fillet feature and
the inside corners remain perpendicular.
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Design Intent in an Assembly

Utilizing symmetry, reusing common parts and S e
using the Mate relation between parts builds the
design intent into an assembly. o
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Example A: Reuse geometry in an assembly. The o
assembly contains a linear pattern of holes. Insert °
one screw into the first hole. Utilize the Component °
Pattern feature to copy the machine screw to the

other holes.
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Design Intent in a Drawing

Utilize dimensions, tolerance and notes in parts and é
assemblies to build the design intent into a drawing.

Example A: Tolerance and material in the drawing.
Insert an inside diameter tolerance +.000/-.002 into
the Pipe part. The tolerance propagates to the S
drawing.

Define the Custom Property Material in the Part. CluieTT N
The Material Custom Property propagates to your

drawing.

w1

‘¥* Create a sketch on any of the default planes:
Front, Top, Right or a created plane or face.

SOLIDWORKS Design  |< EBo® -
P& P
\ .
Intent tools e o,
Hist
Sen
Ann @
Equ B Open Drawing
Add comments, notes or additional SBMat compeent | ] Add Comment
information to features or sketches during g :’° Tree Display
the design period. This will aid you or your i P Document Propertis..
9 Configuration Publisher...
colleagues to recall and to better understand 1, orig
the fundamental design intent of the model

and individual features later. ABC
07/01/2016 10:30 AM Davepl:

Part (Part2)
Hidden Tree Items

Add to Library

Comments

v

Abpearance

Right-click on the name, feature or sketch in
the FeatureManager. Click Comment » Add [Date/Time Stamp| | Cancel || Save and Close | «
Comment. The Comment dialog box is

displayed.
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Enter the information. Click Save and Close. A Comments folder
is displayed in the FeatureManager. Double-click the feature in
the Comments folder to view the comment.

L
A

You can also add a Date/Time stamp to your comment.

Design Binder

Activate the Design binder. Click Options & » System Options
tab » FeatureManager. Select Show from the drop-down menu.
The Design Binder is an embedded Microsoft Word document
that provides the ability for the user to capture a screen image
and to incorporate text into a document.

ConfigurationManager

BlR[e[@ >

©
N

% Part2 (Default<<Default> Disy

- Comments
E Comment1
History

EEEC I

G
N

% Part2 (Default<<Default>_Disy
v Comments
H Comment1
History
Sensors
Design Binder
Design Journal.doc <Ei
4 Annotations

When you create various configurations for assemblies, \E
2 [&le@]

design tables, etc., use the comment area to incorporate | &

a comment for these configurations. Configurations

Dimensions

- % Part2 Configuration(s)

[IFE v Defa‘ 1a Add Derived Configuration...

Shm‘f\)e Preview

To be efficient, reuse existing geometry. Provide
dimensions with descriptive names.

Equations

Modify
< X @ 7 *ﬂg,é&

/kﬁase Sketch

3.266in

>

SOLIDWORKS provides a completely redesigned
dialog box for creating and editing equations, global
variables and dimensions.

Sensors
v Design Binder
Design Journal.doc <Empty3|
» Annotations

Add a comment to the end of an equation to provide b DS 1anae Equations.
clarity for the future. Use descriptive names and SBMa g o Fle Properties
organize your equations to improve clarity. Wro oo,

ol Equations,Global Variabes, and Dimensions

“¥" Create an Excel spread B(C. 2 4] [r i
sheet to input your equations e —
into SOLIDWORKS. Use the I -
Link to external file option. e -
Automatic solve order

[ Automatically rebuild Angular equation units: ~ Degrees -
Link to external file:
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w1

“¥* You can specify the units of measurement for Global
variables, and for the values and equations that define the
global variables. You can define the units in the Equations
and modify dialog boxes for dimensions, and in
PropertyManagers that support equations.

Design Tables

There are a number of ways to incorporate a comment into a
design table. One way is to add “SCOMMENT” to the
heading of a column. This provides the ability to add a
comment in a design table.

Features

Always use descriptive names in the FeatureManager design
tree, not the default feature names such as Boss-Extrudel,
Cut-Extrudel, LPatternl, etc. Group important features

SOLIDWORKS® 2017 Reference Guide

SEB[ol@

éj Boss-Extrude
v X ®

@

From

‘Sketch Plane

Direction 1

lplind
»

File Properties

[ pirection 2

D Thin Feature

Selected Contours

toward the top of the FeatureManager design tree.

Scroll selected item into view

Name feature on creation
w1
y Arrow key navigation

“¥" Enable the FeatureManager Name feature on

creation option: click Options & » System Options »
FeatureManager » Name feature on creation box. The

Dynamic highlight

Enable FeatureManager tree filter

Use transparent flyout FeatureManager tree in parts/assemblies

[ Allow component files to be renamed from FeatureManager tree

Name feature on creation option highlights the feature
name when created and allows the feature to be named.

Identify the Correct Reference Planes

Most SOLIDWORKS features start with a 2D sketch. Sketches are the foundation for

creating features. SOLIDWORKS provides the ability to create either 2D or 3D sketches.

A 2D sketch is limited to a flat 2D Sketch Plane located on a Reference Plane, face or a
created place. 3D sketches are very useful in creating sketch geometry that does not lie on

an existing or easily defined Plane.

Does it matter where you start
sketching? Yes. When you create a
new part or assembly, the three
default planes are aligned with
specific views. The plane you select
for your first sketch determines the
orientation of the part. Selecting the
correct plane to start your model is
very important.
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2D Sketching/Reference Planes

The three default L reference planes,
displayed in the FeatureManager design tree,
represent infinite 2D planes in 3D space:

e Front.

slghf o Fromt
. TOp. econdary Datum Tertiary Datum
° Right.

Planes have no thickness or mass.
Orthographic projection is the process of
projecting views onto parallel planes with L
projectors. These are the default | datum
planes:

e Primary.
e Secondary. Fomary Datur
e Tertiary.

Use the following planes in a manufacturing
environment:

e Primary datum plane: Contacts the part at a minimum of three points.
e Secondary datum plane: Contacts the part at a minimum of two points.
e Tertiary datum plane: Contacts the part at a minimum of one point.

The part view orientation depends on the sketch plane. Compare the Front, Top and Right
Sketch planes for an L-shaped profile in the following illustration. Remember - the plane
or face you select for the base sketch determines the orientation of the part.

| SR

- 20-Profile - -+ FrontFlane - - TopFlane + -+ -Right-Flaneq]
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The six principle views of Orthographic projection listed in the ASME Y14.3 2009
standard are Front, Top, Right, Bottom, Rear and Left. SOLIDWORKS Standard view
names correspond to these Orthographic projection view names.

ASME Y14.3 2009 Principle View Name: SOLIDWORKS Standard
View:
Front Front
Top Top
Right side Right
Bottom Bottom
Rear Back
Left side Left
f(if- Overall drafting standard
“¥ ANSI is the ANSI 2 !
default overall
drafting standard used in the book. B B
w1
“¥" Displayed are the Front, Top, Right and
Isometric views in Third Angle Projection.
Tutorial: Default Reference Planes 4-1 A o EORERRG o
RIGHT ANGLE
Create a New part. Display the default Reference oa  ACham &
planes in the Graphics window. 2 L
1. Click New LJ from the Menu bar. The
Templates tab is the default tab. Part is the _
default template from the New $ Blolel >
SOLIDWORKS Document dialog box. & part! (Defoult<<Defaut> Display
Hislory
2. Click OK. The Part FeatureManager is E%s ssssss
displayed. Use the sketch Origin to understand A
. . EEquanons
the (x-,y-) coordinate location of the sketch and to apply 855 Moterial <not specifed>
sketch dimensions. Each sketch in the part has its own g fronf Qane G
Origin. o
3. Click Front Plane from the FeatureManager design tree. Lo g
The Front Plane is the Sketch plane. The Front Plane is
highlighted in the FeatureManager and in the Graphics
window.
Show the default Reference planes in the Graphics window. F’r‘a,ﬂ\ﬁ .
Select the Front, Top and Right planes. ne o
4. Hold the Ctrl key down. ! L {
5. Click Top Plane and Right Plane from the

FeatureManager design tree.
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6. Release the Ctrl key. % Part1 (Default<<Default>_Display
. . History
7. Right-click Show ® from the Context toolbar. &) sensors
. . o . . » Annotations
8. Click inside the Graphics window. The three planes are [ Equations
displayed in the Graphics window. Note the Plane icon in the 5 Materal <not specifed>
FeatureManager. T~
o
“¥* Rename a feature or sketch for clarity. Slowly click the

feature or sketch name twice and enter the new name when the =
>
old one is highlighted. $ Ble@

Rename the default Reference planes. & Partt (Default<<Default> Display |
9. Rename the Front Plane to Front-PlateA. History

Sensors
10. Rename the Top Plane to Top-PlateB. » [&] Annotations

= Equations
11. Rename the Right Plane to Right-PlateC. :at:ﬁal wnotspecieds
12. Rebuild 8 the model. B ot iten

a Top PlateB
13. Close the model. g Right PlateC

I_. QOrigin

3D Sketching/Reference Planes

Create a 3D Sketch in SOLIDWORKS. A 3D Sketch is typically
used for advanced features such as Sweeps and Lofts or when the
sketch does not lie on an existing or easily definable plane. Most
basic features are created from a 2D Sketch.

There are two approaches to 3D Sketching. The first approach is
called 2D Sketching with 3D Sketch planes. In this approach, you:

1. Activate a planar face by adding a 3D Sketch plane.
2. Sketch in 2D along the plane.

3. Add 3D Sketch planes each time you are required to move
sketch entities to create a 3D sketch.

Using the 2D Sketching with 3D Sketch planes approach provides
the ability to:

e Add relations:
e Between planes.
e Between sketch entities on different planes.
e To planes.
e Define planes.

e Move and resize planes.
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Tutorial: 3D Sketching 4-1

SOLIDWORKS® 2017 Reference Guide

Create a simple 3D Sketch on plane using the line sketch tool.
Create a New LJ part. Use the default ANSI Part template.

1.

2.
3.
4

N

8.

Tutorial: 3D Sketching 4-2

Click Top Plane from the FeatureManager.
Click the Sketch tab from the CommandManager.
Click 3D Sketch On Plane from the Sketch Consolidated

Click the Line e Sketch tool.

toolbar as illustrated. 3DSketchl is active.

Sketch a vertical line through the Origin.

Right-click Exit Sketch (& from the P&

Context toolbar. 3DSketchl1 is displayed
in the FeatureManager and is under

defined.
Close the model.

Sketch Entities

Recent Commands

# 21T 2P N«
% Select

Create the illustrated model. Insert two features: Boss-Extrudel
and Cut-Extrudel. Apply the 3D Sketch tool to create the
Cut-Extrudel feature. System units = MMGS.

1.

Create a New L part in SOLIDWORKS. Use the default

ANSI, MMGS Part template.

Right-click Front Plane from the FeatureManager. This is

your Sketch plane.

Click Sketch E from the Context toolbar. The Sketch

toolbar is displayed.

Click the Corner Rectangle &5 tool from the Consolidated
Rectangle Sketch toolbar. The PropertyManager is

displayed.

Sketch a rectangle as illustrated. The part Origin is located

in the bottom left corner of the sketch.

Insert dimensions.
Right-click Smart Dimension ¢ from the Context

6.

toolbar.

Dimension the sketch as illustrated. The sketch is
fully defined. The sketch is displayed in black.
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History
Sensors
4 Annotations
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Create the first feature for the model. The Extruded Boss/Base
feature adds material to a part. Extrude the sketch to create the first
feature. Apply symmetry.

8. Click Extruded Boss/Base @ from the Features toolbar.

9. Select the Mid Plane End Condition in Direction 1. Enter
100.00mm for Depth in Direction 1. Accept the default

conditions. Click OK ¥ from the Boss-Extrude

PropertyManager.
‘¥ The Instant3D tool provides the ability to drag geometry and
dimension manipulator points to resize features or to create new
features directly in the Graphics window. Click the face. Select a
manipulator point. Click and drag. Click a location along the ruler
for the required dimension. The rule increments are set in System
Options.

10. Create 3DSketch1. 3DSketch1 is a four point sketch. Click 3D
Sketch On Plane from the Consolidated Sketch toolbar as
llustrated.

11. Click the Line 7 Sketch tool. 3DSketchl is a four point

sketch as illustrated. 3DSketch1 is the profile for Cut-Extrudel.

12. Locate the first point of the sketch. Click the back right
bottom point as illustrated. Locate the second point of the
sketch. Click the top left front point as illustrated. Locate the
third point of the sketch.

13. Click the bottom right front point as illustrated.

Locate the fourth point of the sketch.
14. Click the back right bottom point as illustrated to close the
sketch.

Design Intent, Sketching and Sketch Entities

SBERlol@
@) Bogs-Extrude @
Ao

From

Direction 1 ~
o
)| —

Draft outward

[ Thin Feature

Selected Contours

Dimension
S

C Sketch

(30 3D sketch
WD 3D Sketch On Plane

Create the Cut-Extrudel feature.
15. Click Extruded Cut @ from the Features toolbar.
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16. Click the front right vertical edge as illustrated to remove
the material. Edge<1> is displayed in the Direction of
Extrusions box.

17. Click OK ¢ from the Cut-Extrude PropertyManager.
Cut-Extrudel is displayed in the FeatureManager.

18. Close the model.

w1

“¥" Select the front right vertical edge or the Top face to remove
the required material in this tutorial.

The second approach to create a 3D Sketch in SOLIDWORKS is

3D Sketching. In this approach: =
e TR s ER® >

1. Open an existing 3D Sketch. T
2. Press the Tab key each time you need to move your sketch @ S':::i"g 7 (Defaulte<Defaut

entities to a different axis. Sens:g
The sketch origin is placed wherever you start the sketch. > [&] Anmotations

Equations
Tutorial: 3D Sketching 4-3 ) MEeTE]) <ansf etz
Apply the 3DSketch tool to create a 3DSketch using the Tab % ::pn;:::e
key to change Sketch planes. 7 ion{ 7w
“

1. Open 3D Sketching 4-3 from the SOLIDWORKS 2017 1 O”gi 1

folder 203 Edit Setch

N Feature (3DSketch1)

Edit the 3D Sketch.
2. Right-click 3DSketch from the FeatureManager.
3. Click Edit Sketch v from the Context toolbar.

3DSketchl is displayed in the Graphics window.
4. Click the Line < Sketch tool. Note: The mouse L

feedback icon. XY
5. Click the right endpoint of the sketch as

illustrated.
6. Press the Tab key to change the Sketch plane

from XY to YZ. The YZ icon is displayed on the

mouse pointer.
7. Sketch a line along the Z axis approximately 7-L;.97

130mm as illustrated. —

8. Press the Tab key twice to change the sketch
plane from YZ to XY. The XY icon is displayed
on the mouse pointer.

Page 4 - 12



SOLIDWORKS® 2017 Reference Guide

9. Sketch a line back along the X axis approximately
30mm.

10. Sketch a line on the Y axis approximately 30mm.
11. Sketch a line along the X axis of approximately 130mm.

Deselect the Line Sketch tool.
12. Right-click Select. View the 3D Sketch.

13. Rebuild 8 the model.
14. Close the model.

Tutorial: 3D Sketching 4-3A

Apply the circle sketch tool to create a Sweep along a 3D
sketch.

1. Open 3D Sketching 4-3A from the SOLIDWORKS
2017 folder.

Create the 2D sketch.
2. Right-click Right Plane from the FeatureManager.

3. Click Sketch.
4. Display a Right view.
5. Sketch a circle at the origin as illustrated.

Create a Swept Bose feature.
6. Click Swept Boss/Base from the Features
CommandManager.

Design Intent, Sketching and Sketch Entities

507
Lo

SERIC[@ >
v

& @ 3D Sketching 4-3A (Default<<D)
4 History

Sensors
» Annotations

Equations

§5 Material <not specified>

ﬂ Front Plane

N ﬂ Top Pla
PO
Right PI ﬁ -
I_. origin |Fsketch tightBlane)

@ 3DSket [GJ, 2D Sketch On Plan|

N
NI

7. Click the Circular Profile box.

D’SSOLIDWORKS‘ File Edit View Insert Tools Window Help |

8. Enter .10in for diameter.
9. Click the 3D Sketch (path) in the graphics window.

o
Features ‘ Sketch‘ Evaluate (.

aQl S & Sweptgoss/Base

Extruded Revolved
Boss/Base Boss/Base

Swept Boss/Base
Sweeps a closed profile along an
pen or closed path to create a solid
ature.

10. Click OK. View the
results in the graphics
window.

11. Close the model.

Path(3DSketch1)
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Tutorial: 3D Sketching 4-4

Utilize the 3D Sketch placement method. Insert a hole on a
cylindrical face using the Hole Wizard.

1. Open 3D Sketching 4-4 from the SOLIDWORKS 2017
folder. Note: With a 3D sketch, press the Tab key to move
between planes.

2. Click the Hole Wizard & feature tool.

3. Create a Counterbore, ANSI Inch, Socket Head Cap
Screw fastener Type. Size - V4. Fit - Normal. End
Condition - Through All with a .100in Head clearance.

4. Click the Positions Tab.

Click the 3D Sketch button. The Hole Position
PropertyManager is displayed. SOLIDWORKS displays an

active 3D interface with the Point XY « tool.

w1

“¥" When the Point tool is active, wherever you click you will
create a point.

Dimension the sketch.

6. Click the cylindrical face of the model as illustrated.
The selected face is displayed in orange. This indicates
that an OnSurface sketch relations will be created
between the sketch point and the cylindrical face. The
hole is displayed in the model.

7. Insert a .25in dimension between the top face and the
sketch point.

Locate the point angularly

around the cylinder. Apply

construction geometry.

8. Display the Temporary
Axes.

g
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S BERoe |
@ Hole Specification @

Pt type [ postions| |

Favorite A2 A

Options
Hea rance
ﬁ 0.100in :

Hole Type

Standard:

‘ANSI Inch ﬂ

Type:
‘Socket Head Cap Screw A, ‘

el
CIEIE)
/ BlEe

/

Hole Specifications A

‘Normal N7 ‘

[[J show custom sizing

End Condition 2
Through All v
A
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9. Click the Line e Sketch tool. Note: 3D Sketch is still
activated.

10. Ctrl + Click the top flat face of the model. This moves
the red space handle origin to the selected face. This also
constrains any new sketch entities to the top flat face.

Note the mouse pointer # < icon.

11. Move the mouse pointer near the center of the activated
top flat face as illustrated. View the small black circle. The
circle indicates that the end point of the
line will pick up a Coincident relation.

12. Click the center point of the circle.

13. Sketch a line so it picks up the AlongZ
sketch relation. The cursor displays the
relation to be applied. This is a very
important step.

Deselect the Line Sketch tool.
14. Right-click Select.

15. Create an AlongY sketch relation
between the center point of the hole on
the cylindrical face and the endpoint of
the sketched line. The sketch is fully
defined.

16. Click OK ¥ from the
PropertyManager.

Add Relations ~

17. Click OK ¥ to return to the Part
FeatureManager.

18. Expand the FeatureManager and view
the results. The two sketches are fully
defined. One sketch is the hole profile,
the other sketch is to define the position
of the feature.

19. Close the model.

L

“¥* Create a second sketched line and insert an angle dimension
between the two lines. This process is used to control the position
of the center point of the hole on the cylindrical face as
illustrated. Insert an AlongY sketch relation between the center
point of the hole on the cylindrical face and the end point of the
second control line. Control the hole’s position with an angular

dimension.
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SERC@ >
v

% 3D Sketching 4-4 (Default<<D¢

4 History
Sensors

» Annotations
Equations
28 1060 Alloy
ﬂj Front Plane
m Top Plane
m Right Plane
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" The main advantage of the 3D Sketch placement method is that it can place a set of
holes on any set of solid faces, regardless of whether they are at different levels or are
non-parallel. A limitation: 3D sketches can be fairly cumbersome and difficult. See
section on 3D Sketching in SOLIDWORKS Help for additional details.

2D Sketching/Inserting Reference Planes

Reference Planes are geometry created from existing planes, faces,

vertices, surfaces, axes, and or sketch geometry. To access the Plane
PropertyManager, click Insert > Reference Geometry > Plane from

the Menu bar or click the Plane i tool from the Consolidated

Reference Geometry Features toolbar.

Plane Tool

The Plane ¥ tool uses the Plane
PropertyManager. The Plane
PropertyManager provides the following
selections:

o First Reference. Select a face, plane or
edge to create a reference plane. These
options are available:

¢ Reference Entities. Displays the
selected planes either from the
FeatureManager or from the
Graphics window.

e Parallel. Creates a plane parallel to
the selected plane. For example,
select a face for one reference and a
point for another reference. The
created plane is parallel to the face
and coincident to the point.

o

Yy
Reference| Curves
Geometry

| ’ Plane

e 9
7 Axi
5 IS

)—r Coordinate System
@ Point

Q Center of Mass

ﬂ] Mate Reference

e Perpendicular. Creates a plane perpendicular to the
selected reference. For example, select an edge or curve for
one reference and a point or vertex for another reference.
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e Coincident. Creatgs a}plane @ EBlole EBEEER
through a point coincident to a i Plane
plane or a face. W e

v X v X -

e Project. Projects a singular entity Message ~ | [Message ~ A
such as a point, vertex, origin, or Select references and constraints | | Fully defined
coordinate system onto a non-planar | irst Reference A | [First Reference
surface. Select the sketch pointand | @ [ IRl m
the model surface. Two options Second Reference - Parallel
appear in the PropertyManager: all | Perpendicular
e Nearest location on surface. A e— ~ Scicident

' | |90de
e Along sketch normal. 7] | | g

e Tangent. Creates a plane tangent to OPtionsFl_ | " [ Fiip offset
cylindrical, conical, non-cylindrical, — A
and non-planar faces. Select a =] Mid plane
surface and a sketch point on the e o
surface. The plane is created tangent @ I:l

to the surface and coincident to the sketch point.

Third Reference

* At Angle. Select a plane or planar face and select an edge, | @ l:|
axis, or sketch line. You can specify the number of planes

. Options
to create. Enter the angle value in the angle box. ’ ] Fiip normal
e Offset Distance. Creates a plane parallel to a plane or face ,

. . : ’ S SN )
offset by a specified distance. You can specify the number of ?ﬂm @
planes to create. Enter the Offset distance value in the -
distance box. — ~ I
e Reverse direction. :u"’: :e:"Ed

Reverses the direction of the m
angle if required. »
Paralle
e Numbers of Planes to Perpendicular
Create. Displays the Coincident
selected number of planes. i 50deg
. ) 0.100in
e Mid Plane. Creates a mid-plane éMid olane
between planar faces, reference —
planes, and 3D sketch planes. @ M
Select Mid Plane for both (L] erpendiutr
references. Comcident
- Project
Third Reference
7! I:I
Options v
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Tutorial: Reference Plane 4-1

Create three Reference planes using the Offset Distance option from % P Rlole >
the Plane PropertyManager. ane
v X~
1. Create a New LJ part. Use the default ANSI Part template.
Set system units to MMGS. Message s
Fully defined
2. Dlsplay an Isometric view. First Reference

Parallel

3. Right-click Top Plane from
the FeatureManager design

tree. Perpendicular
4. Hold the Ctrl key down. Coincident
Click and drag the 90.00deg

o E—

O Flip offset

Ll

boundary of the Top Plane
upwards in the Graphics
window. The Plane

PropertyManager is =] Mid Plane
displayed. Top Plane is displayed in the First Reference box. |
6. Release the Ctrl key and mouse pointer. Q I:|
7. Enter 25mm in the Distance. The Plane is offset by Third Reference

25mm. @:

8. Enter 3 in the Number of planes to create box.

9. Click OK ¥ from the Plane PropertyManager.
Planel, Plane2 and Plane3 are created and
displayed in the Graphics window. Each Plane is
offset from the Top Plane a distance of 25mm.

10. Close the model.

Tutorial: Reference Plane 4-2

Use the Plane PropertyManager to create two angled

Reference planes from an edge at a 45 degree angle.

1. Open Reference Plane 4-2 from the
SOLIDWORKS 2017 folder.

2. Click Right Plane from the FeatureManager
design tree.

3. Click Insert > Reference Geometry > Plane from
the Menu bar. The Plane PropertyManager is
displayed. Right Plane is displayed in the First
Reference box.

4. Click the At angle button.
5. Enter 45deg for Angle.
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6. Click the front vertical edge of Extrudel as illustrated. Do not select the midpoint.
Edge<1> is displayed in the Selections box. The model is fully defined.

7. Enter 2 in the Number of planes to create box.

8. Click OK ¥ from the Plane PropertyManager. Planel and
Plane?2 are displayed in the FeatureManager and in the
Graphics window.

9. Close the model. S b
D _
Tutorial: Reference Plane 4-3 . C et
oinciden
Use the Plane PropertyManager to m —
create a Reference plane using >
three vertices (Coincident) to the lﬁii‘ 0

Extrudel feature.

1. Open Reference Plane 4-3
from the SOLIDWORKS
2017 folder.

2. Click Insert > Reference
Geometry > Plane. The e
Plane PropertyManager is Third Reference

displayed. gl |

3. Click three Vertices as . Com dent
illustrated. Vertex<1>, =
Vertex<2> and EI Project
Vertex<3> are displayed lﬁi" L
Options A

Second Reference

. Coincident
Project

in the Reference Entities

boxes. The model is fully
defined.

4. Click OK ¥ from the
Plane PropertyManager.
The angled Planel is
created and is displayed in
the FeatureManager and the Graphics window.

5. Close the model.

as Fully define all sketches in the model. However,
there are times when this is not practical, generally when

using the Spline tool to create a complex freeform shape.
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Tutorial: Reference Plane 4-4

Use the Plane PropertyManager to create a Reference plane
parallel to an existing plane through a selected point.

1. Open Reference Planes 4-4 from the SOLIDWORKS 2017
folder.
2. Click the Plane i tool from the Consolidated Reference

Geometry Features toolbar. The Plane PropertyManager is

SOLIDWORKS® 2017 Reference Guide

-* Plane

LR

Reference| Curves [|nstant3D

Geometry

~

i .
d
/ Axis

J—» Coordinate System

@ Point
Q Center of Mass
dm Mate Reference

displayed.
Click the front top right vertex.

4. Click the Right Plane from the fly-out FeatureManager. The

model is fully defined.

5. Click OK ¥ from the Plane PropertyManager. Planel is
created and is displayed in the FeatureManager and Graphics

window. Close the model.

=

f=]

N

o)

=
o

[=3

\

=
R,

Parent/Child Relationship

A Parent feature or sketch is an existing feature or sketch on which others depend.
Example of a Parent feature: An Extruded feature is the Parent feature to a fillet which

rounds the edges.

When you create a new feature or sketch which is based on other features or sketches,
their existence depends on the previously built feature or sketch. The new feature or
sketch is called a Child feature or a Child sketch. Example of a Child feature: A hole is

the child of the Base-Extrude feature in which it is cut.

Tutorial: Parent-Child 4-1

View the Parent/Child relationship in an assembly for a

feature and a sketch from a component.

1. Open the AirCylinder Linkage assembly from the
SOLIDWORKS 2017\Solutions folder.

2. Expand RodClevis<1> from the AirCylinder
Linkage assembly FeatureManager.

3. Right-click Base-Extrude. View the information
in the FeatureManager.

4. Click Parent/Child. The Parent/Child
Relationships dialog box is displayed. View the
Sketch2 relationships.

5. Click Close from the Parent/Child Relationships
dialog box.
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View the Parent/Child Relationships for a

feature.

6. Right-click Sketch2 from Base-Extrude in
the FeatureManager design tree.

7. Click Parent/Child. View the Base-
Extrude feature relationships.

8. Click Close from the Parent/Child
Relationships dialog box.

9. Close the model.

Design Intent, Sketching and Sketch Entities

&0 Parent/Child Relationships X
Parents Children
= L Sketch2 = L Sketch2
Eg Front @ Base-Extrude
L Origin

Sketch States

Sketches can exist in any of five states. The state of the sketch is displayed in the status

bar at the bottom of the SOLIDWORKS window.

SOLIDWORKS:

n s
AT

There are five sketch states in

Color indicates the state of the individual Sketch entities.

1. Under Defined. Inadequate definition of the sketch, (blue). The FeatureManager
displays a minus (-) symbol before the Sketch name.

2. Fully Defined. Complete information, (black).

symbol before the Sketch name.

The FeatureManager displays no

3. Over Defined. Duplicate dimensions and or relations, (orange -red). The
FeatureManager displays a (+) symbol before the Sketch name. The What’s Wrong

dialog box is displayed.

4. Invalid Solution Found. Y our sketch is solved but results in invalid geometry; for
example, a zero length line, zero radius arc or a self-intersecting spline (yellow).

5. No Solution Found. Indicates sketch geometry that cannot be resolved (Brown).

w 1

“¥* The SOLIDWORKS SketchXpert is designed to assist in an O ERloe

over defined state of a sketch. The SketchXpert generates a list of
causes for over defined sketches. The list is organized into
Solution Sets. This tool enables you to delete a solution set of over

4 SketchXpert @

v X

Message ~

deﬁned dlmenSIOnS or redundant I‘elatiOHS Wlthout COl’l’lpI‘OIl’llSll’lg Press "Diagnose" to find solutions to

your design intent.

w1

the sketch error.

Press "Manual Repair” to list all the

AR Click Options & » System Options > Sketch, and click relations with errors.
the Use fully defined sketches option to use fully defined sketches Manual Repair

for created features.
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AR Apply dimensions and relations calculated by the SOLIDWORKS application to
fully define sketches or selected sketch entities. Use the Fully Defined Sketch
PropertyManager.

mgm inse Line
S ketc h E ntltles g E::ial Ellipse é Corner Rectangle
\J Parabola =] Center Rectangle
Sketch entities provide the ability to create lines, [\ conic <> 3 Point Comer Rectangle
rectangles, parallelograms, circles, etc. during the (U spine <> 3 Point Center Rectangle

N Style Spline H Parallelogram
Straight Slot
Centerpoint Straight Slot

sketching process. To access the available sketch
entities for SOLIDWORKS, click Tools > Sketch & Equation Driven Curve

Entities from the Menu bar menu and select the = Point @ 3 point A st

required entity. This book does not go over each " Centerline Centerpoint Arc Slot

individual Sketch entity in full detail but will address | Mdomtre ( Polygon

the more advanced entities. A Ter. @ cide

To obtain additional information of each sketch ; g Perimeter Circle

entity, activate the sketch entity and click the & setucran _D :::t:rnii"rzm

question mark @ icon located at the top of the entity Customize Men ~ 3 pogim are

PropertyManager or click Help > SOLIDWORKS

Help Topics from the Menu bar and search by using

one of the three available tabs: Contents, Index, or

Search.

Line Sketch Entity AR
\ /" Insert Line @

The Line Sketch entity /* tool provides the ability to sketch v x

multiple 2D lines in a sketch. The Line Sketch entity uses the
Insert Line PropertyManager. The Insert Line PropertyManager

Message ~

Edit the settings of the next new line

prOVides the fOHOWil’lg selections: or sketch a new line.
e Orientation. The Orientation box provides the following Orientation ~
tiOl’lS' @ As sketched
Op ‘ O Horizontal
e As sketched. Sketch a line in any direction using the O Vertical
click and drag method. Using the click-click method, O Angle
the As sketched option provides the ability to sketch a Options A

I:‘ For construction
D Infinite length
O Midpoint line

line in any direction, and to continue sketching other
lines in any direction, until you double-click to end your
process.

e Horizontal. Sketch a horizontal line until you release
your mouse pointer.

e Vertical. Sketch a vertical line until you release your mouse pointer.

e Angle. Sketch a line at an angle until you release your mouse pointer.
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e Options. The Options box provides three line types: °rient(a)ticn " ~
As sketche
e For construction. Converts the selected sketch entity to gHmimm'
i Vertical
construction geometry. S
¢ Infinite length. Creates a line of infinite length which you  |optiens . ~
can later trim in the design process. Cfor constructon
[Cinfinite length
e Midpoint line. Create a line that is symmetrical from the o paelhes
midpoint of the line. P;r\ameters o
e Parameters. You can specify any appropriate combination of ke 000 I

the following parameters (or Additional Parameters) to define
the line if the line is not constrained by relations. When you
change one or more parameters, the other parameters update
automatically.

w s

“¥" Use Construction geometry to assist in creating your sketch entities and geometry
that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a
centerline.

w1

“¥" The plane or face you select for the Base sketch determines the orientation of the
part.

Rectangle and Parallelogram Sketch Entity %MME ee ®

v

Rectangle Type A

The Rectangle Sketch entity § tool provides the ability to sketch a =

Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle and a
3 Point Center Rectangle. The Parallelogram Sketch entity provides @

o

the ability to sketch a Parallelogram. WL
The Rectangle and Parallelogram Sketch entity uses the Consolidated | - o
Rectangle PropertyManager. The Rectangle PropertyManager (000
provides the following selections: “ 000
e Rectangle Type. The Rectangle Type box provides five 0:00
selections: ., 000
e Corner Rectangle. Sketch a standard rectangle at a corner w00

0.00

point. Click to place the first corner of the rectangle, drag, and | ™
release when the rectangle is the correct size and shape.

e Center Rectangle. Sketch a rectangle at a center point. Click to define the center.
Drag to sketch the rectangle with centerlines. Release to set the four edges.

¢ 3 Point Corner Rectangle. Sketch a rectangle at a selected angle. Click to define
the first corner. Drag, rotate, and then release to set the length and angle of the
first edge. Click and drag to sketch the other three edges. Release to set the four
edges.
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3 Point Center Rectangle. Sketch a rectangle with a center
point at a selected angle. Click to define the first corner.
Drag and rotate to set one half the length of the centerlines.
Click and drag to sketch the other three edges and
centerlines. Release to set the four edges.

Parallelogram. Sketch a standard parallelogram. A
Parallelogram is a rectangle whose sides are not horizontal
or vertical with respect to the sketch grid. Click to define
the first corner. Drag, rotate, and then release to set the
length and angle of the first edge. Click, rotate, and drag to
set the angle and length of the other three edges. Release to
set the four edges.

e Add construction lines. Converts the entities to construction
geometry.

From Corners. Adds centerlines from corner to corner.

From Midpoints. Adds centerlines from midpoint of line
segments.

e Parameters. Specify the appropriate combination of parameters
to define the rectangle or parallelogram if they are not
constrained by relations.

Slot Sketch Entity

The Slot Sketch entity >’ tool provides the ability to sketch a
Straight Slot, Centerpoint Straight Slot, 3 Point Arc Slot and a
Centerpoint Arc Slot from the Consolidated Slot toolbar.

The Slot Sketch entity uses the Consolidated Slot PropertyManager.
The Slot PropertyManager provides the
following selections:

e Slot Type. The Slot Type box provides
four selections:

Straight Slot. Sketch a three point
slot.

Centerpoint Straight Slot.
Sketch a three point slot located
at an Origin or centerpoint.

3 Point Arc Slot. Sketch a four point
arc slot.
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Parameters 2
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°, | 0:00
o, |0.00
o 0.00
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[ 0.00
oy 0.00
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Centerpoint Arc Slot. Sketch a four point arc slot

located at an Origin or reference point. RS51

Add dimensions. Insert dimensions as you sketch
the slot.

Center to Center. Insert center to center dimension
if the Add dimensions box is checked.

Overall Length. Insert overall length if the Add
dimensions box is checked.

Parameters. Provides the ability to specify the appropriate
combination of parameters to define slot if they are not
constrained by relations. The parameters box provides the
following options: Center X Coordinate, Center Y
Coordinate, Radius of Arc, Angle of Arc, Slot Width, Slot
Length.

Tutorial: Slot Sketch - Instant3D 4-1

Utilize the Slot Sketch tool. Create an Extruded Boss/Base and
Extruded Cut feature using the Instant3D tool.

1.

Create a New |J part. Use the default ANSI, IPS Part
template.

Right-click Front Plane from the FeatureManager.

Click Sketch (_ from the Context toolbar.
The Sketch toolbar is displayed.

Click Centerpoint Straight Slot & from

the Consolidated Slot toolbar as illustrated.
The Slot PropertyManager is displayed. If

needed, uncheck the Add dimension box.

287

1% =

Design Intent, Sketching and Sketch Entities

I:‘Add dimensions

Op Center to Center

D For construction

Parameters
Cx
Gy

0.00mm
0.00mm
0.00001mm

D
=
] 0.00001Tmm

o -

Tty

Straight Slot

' 3 Point Arc Slot

Centerpoint Arc Slot

Centerpoint Straight Slot

Click the Origin.
Click a position directly to the right of the

Origin.

Click a position directly above the second
point as illustrated.

Dimension the slot sketch.

8.

Right-click Smart Dimension € from the

Context toolbar in the Graphics window.

Dimension the model as illustrated. The

sketch is fully defined. Note the location of

the Origin.
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Apply the Instant3D tool. Create an Extruded Boss/Base feature. The
Extruded Boss/Base feature adds material to a part. Note: Edit the ‘S
feature, and view the PropertyManager to confirm that you picked Reference Curves
the correct dimension with the on-screen ruler. The Instant3D tool ceometry
does not provide various End Conditions for Design Intent.

Exit Sketchl.

10. Right-click Exit Sketch & Note: Instant3D
is active by default. If needed click Instant3D
from the Features tab.

11. Display an Isometric view.

Create an Extruded Boss/Base feature with a

default Blind End Condition.

12. Click the top edge as illustrated. A green
arrow is displayed. Drag the arrow forward
and click the on-screen ruler approximately
0.25in.

13. View Boss-Extrudel in the FeatureManager. Direction 1 ~ 0
) il'l -
14. Edit Boss-Extrudel in the FeatureManager. —
»
15. Enter Depth = .30in. Click OK + from the I
PropertyManager. %3 oo =
Create an Extruded Cut feature using Instant3D.
16. Display a Front view. | =
[ Draft outward

17. Right-click the Front face. This is your Sketch plane.

18. Click Sketch i from the Context toolbar. The Sketch toolbar
is displayed.

19. Click the Circle G Sketch tool.

20. Sketch a circle centered at the Origin as illustrated.

Exit the Sketch.
21. Right-click Exit Sketch.

22. Display an Isometric view.

Create an Extruded Cut feature.
23. Click the circumference of the sketch as illustrated.

24. Click and drag the arrow backwards to create a hole in the
model. Note: The default End Condition is Blind.

25. Release the mouse icon behind the model. The Cut-Extrudel
feature is displayed. View the model.
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26. Close the model.

Polygon Sketch Entity S ERI¢ @
o Polygon @
The Polygon Sketch entity ;F} tool provides the ability to create v
equilateral polygons with any number of sides between 3 and Options _ ~
40. The Polygon Sketch entity uses the Polygon LS
PropertyManager. The Polygon PropertyManager provides the P“""“T“ -
following selections: @ ‘ v
@ Inscribed circle
o Existing Relations. The Existing Relations box displays O Circumscribed circle
information on existing relations of the polygon sketch. G |00 :
e Add Relation. The Add Relation box displays the selected @& |0 :
relations to the points and lines of your polygon sketch. O \6.81909767 g
g oo s
“¥* You cannot add a relation to a complete polygon. You can New pol
. . . ew Polygon
only add a relation to the points and lines of the polygon.
e Options. The Options box provides the following selection:
e For construction. Not selected by default. Converts the
selected sketch entity to construction geometry.
e Parameters. The Parameters box provides the ability to
specify the appropriate combination of parameters to define
the polygon. When you modify or change one or more
parameters, the other parameters update automatically.
These are the available selections: o
. . ° 3
e Number of Sides. Sets the number of sides in your /'/d 0
polygon. / =0 \;"D
e Inscribed circle. Selected by default. Displays an g k ;» B
inscribed circle inside the polygon. This option /
defines the size of the polygon. The circle is 0 / o
construction geometry. \Dk_»o_/

e Circumscribed circle. Displays a circumscribed
circle outside of the polygon. This option defines the size
of the polygon. The circle is construction geometry. B

e Center X Coordinate. Displays the X coordinate for
the center of your polygon.
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e Center Y Coordinate. Displays the Y coordinate
for the center of your polygon.

e Circle Diameter. Displays the diameter of the
inscribed or circumscribed circle.

e Angle. Displays the angle of rotation.

e New Polygon. Creates more than a single polygon
without leaving the PropertyManager.

Tutorial: Polygon 4-1

Create a new part using the Polygon Sketch entity.

1. Create a New L part. Use the default ANSI Part
template.

2. Right-click Top Plane from the FeatureManager
design tree. This is your Sketch plane.

3. Click Sketch & from the Context toolbar. The Top
Plane boundary is displayed in the Top view.

4. Click the Cirele & Sketch tool. The Circle
PropertyManager is displayed.
5. Sketch a circle centered at the origin.

Insert a polygon.

6. Click Tools > Sketch Entities > Polygon from the
Menu bar or click Polygon from the Sketch toolbar.
The Polygon PropertyManager is displayed.

7. Sketch a Polygon centered at the Origin larger than
the circle as illustrated.

8. Click OK ¥ from the Polygon PropertyManager.

9. Rebuild 9 the model. View the created Polygon in
the Graphics window.

10. Close the model.

w1

“¥* For illustration purposes, the Reference planes and
grid are hidden.
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Circle Sketch and
Perimeter Circle Sketch
Entity

The Circle Sketch and Perimeter Circle

Sketch entity & tool provides the ability
to control the various properties of a
circle.

The Circle Sketch and Perimeter Circle
Sketch entity uses the consolidated Circle
PropertyManager. The consolidated Circle
PropertyManager provides the following
selections:

Design Intent, Sketching and Sketch Entities

e Circle Type. Provides the ability to select either a center
based circle or a perimeter-based circle sketch entity.

o Existing Relations. The Existing Relations box provides the

following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

Add Relations. Provides the ability to add relations to the

selected entity. Displays the relations which are possible for

the selected entity.

Options. For construction. Not selected by default. Converts

the selected entity to construction geometry.

Parameters. Specifies the appropriate combination of

parameters to define the circle if the circle is not constrained
by relations. These are the available selections:

e Center X Coordinate. Sets the Center X Coordinate

value.

e Center Y Coordinate. Sets the Center Y Coordinate

value.

e Radius. Sets the Radius value.
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The Perimeter Circle Sketch entity provides the ability to define
a circle using 3 points along its perimeter. This sketch entity is
very useful when you are not concerned about the location of the
center of the circle.

Tutorial: Perimeter Circle 4-1
Create a Perimeter Circle sketch.

1. Create a New ] part. Use the default ANSI Part template.

2. Right-click Front Plane from the FeatureManager. This is
your Sketch plane.

3. Click Sketch C from the Context toolbar. I

4. Click the Line e Sketch tool. The Insert Line
PropertyManager is displayed.

5. Sketch two lines as illustrated.

Sketch a circle that is tangent to both lines. E& V- 5 f.&
6. Click Perimeter Circle from the Consolidated Circle d @ Circle
Sketch toolbar. The Circle PropertyManager is ™3 Perimeter Circle
displayed.

7. Click each line once.

8. Click a position as illustrated to determine the size of o
the circle. The X coordinate, Y coordinate, and Radius
are displayed in the Parameters box. The two lines are
tangent to the circle. You created a simple circle using
the Perimeter Circle sketch entity.

9. Click OK ¥ from the Circle PropertyManager. View > L
the model.

10. Rebuild 8 the model.
11. Close the model.

w1

“¥" If the two lines change, the circle remains tangent to

the llnes. Line length measured between virtual sharps in 3d

| Enable spline tangency and curvature handles

AR In System Options, under the Sketch folder, apply host image o g
the Ghost image on drag option. The option displays a %srmw carvature comb bounding curve

ghost image of a sketch entities' original position while [ scale sketch on first dimension creation
you drag the sketch in the GraphiCS window. [C]Enable on screen numeric input on entity creation

I:‘ Show spline control polygon by default
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Centerpoint Arc Sketch
Entity

The Centerpoint Arc Sketch entity & tool
provides the ability to create an arc from
a center point, a start point, and an end
point. The Centerpoint Arc Sketch entity
uses the consolidated Arc
PropertyManager.

The Arc PropertyManager controls the
properties of a sketched Centerpoint Arc,
Tangent Arc and 3 Point Arc.

The consolidated Arc PropertyManager
provides the following selections:

e Arc Type. Provides the ability to
select a Centerpoint Arc, Tangent Arc
or 3 Point Arc sketch entity.

Design Intent, Sketching and Sketch Entities

o Existing Relations. The Existing Relations box provides the

following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

Add Relations. Provides the ability to add relations to the

selected entity. Displays the relations which are possible for

the selected entity.

construction geometry.

Options. For construction. Converts the selected entity to

Parameters. Provides the ability to specify any appropriate

combination of parameters to define your arc if the arc is not
constrained by relations. The available selections are
Center X Coordinate, Center Y Coordinate, Start X
Coordinate, Start Y Coordinate, End X Coordinate, End

Y Coordinate, Radius and Angle.
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Tutorial: Centerpoint Arc 4-1
Create a Centerpoint Arc sketch.
1. Create a New L] part. Use the default ANSI

SOLIDWORKS® 2017 Reference Guide

Part template. ',-"'J"'- e
2. Right-click Front Plane from the _,-"f
FeatureManager. This is your Sketch plane. -
3. Click Sketch C from the Context toolbar.
4. Click the Line 7 Sketch tool. Sketch a
horizontal line through the origin as illustrated.
5. Click Centerpoint Arc ** from the N
Consolidated Arc Sketch toolbar. The Arc ",
icon is displayed on your mouse pointer.
6. Click a location on the horizontal line left of °
the origin. Do not pick the origin or the
endpoint. _ T_
7. Click a position to the right and up on the o m=
horizontal line. Drag to set the angle and the
radius of the arc. Release the mouse button to place the arc.
View the Arc PropertyManager and the coordinates.
8. Click OK ¥ from the Arc PropertyManager.
9. Rebuild 9 the model. Close the model.
Tangent Arc Sketch Entity
[SIE[R[S]@®
7 Arc @

The Tangent Arc Sketch entity % tool provides the ability to create
an arc, which is tangent to a sketch entity. The Tangent Arc Sketch
entity uses the Arc PropertyManager. View the Centerpoint Arc
Sketch entity section above for additional information on the Arc
PropertyManager.

w1

“¥" You can transition from sketching a line to sketching a
Tangent Arc, and vice versa without selecting the Arc tool from the
Sketch toolbar. Example: Create a line. Click the endpoint of the
line. Move your mouse pointer away. The Preview displays another
line. Move your mouse pointer back to the selected line endpoint.
The Preview displays a tangent arc. Click to place the arc. Move
the mouse pointer away from the arc endpoint. Perform the same
procedure above to continue.
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Tutorial: Tangent Arc 4-1

1.
2.

3.

10.

11.
12.

Design Intent, Sketching and Sketch Entities

Create a Tangent Arc sketch. & Bl & >
Create a New L part. Use the default ANSI Part template. g
Part3 (Default<<Default>_Dis
Right-click Front Plane from the FeatureManager. History
. Sensors
Click Sketch & from the Context toolbar. » [[) Design Binder
4 Annotations
Click the Line 7 Sketch tool. &1 Equations
Sketch a horizontal line through the Origin. g; zaT ®pLd
= Front Plane)
Click Tangent Arc 2 from the Consolidated Arc Sketch % ;g [, 3D Sketch On PI3
toolbar. The Arc icon is displayed on the mouse pointer. s
Click the left end point of the horizontal line.
Drag the mouse pointer upward and to the left for T E0IP R =452
the desired shape.
Click an end point. You created a Tangent Arc. The ,
Arc PropertyManager is displayed. £
Right-click Select in the Graphics window to
deselect the Sketch tool.
Click OK ¥ from the Arc PropertyManager.
Exit the sketch. Close the model. - a

w1

-~

" You can select an end point of a line, ellipse,

arc or a spline. The Tangent Arc tool creates both
Normal and Tangent Arcs.

3 Point Arc Sketch Entity

The 3 Point Arc Sketch entity & tool provides the ability to create

an arc by specifying three points: a starting point, an endpoint, and a

midpoint. View the Centerpoint Arc Sketch entity section for
additional information on the Arc PropertyManager.

Tutorial: 3 Point Arc 4-1
Create a 3Point Arc sketch.

1.

Open 3 Point Arc 4-1 from the

N Arc

4

SOLIDWORKS 2017 folder. YOXE
Edit Sketchl . oRo
Click 3 Point Arc ¢ * from the Consolidated 2 f:j:t:

'

3 Point Arc|

Arc Sketch toolbar.
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Click the top point of the vertical line for the start point as
illustrated.

Click the right point of the open circle for the
end point as illustrated.

Drag the arc downward to set the radius.

7. Click a position for the midpoint of the 3Point A

Arc. '
8. Click OK ¥ from the Arc PropertyManager. )
9. Rebuild 9 the model. 1
10. Close the model.
Ellipse Sketch Entity

S BERl¢l@

The Ellipse Sketch entity o tool provides the ability to create a © Ellipsa @
complete ellipse. The Ellipse PropertyManager controls the M
properties of a sketched Ellipse or a Partial Ellipse. The Ellipse Existing Relations ~
PropertyManager provides the following selections: b

Existing Relations. The Existing Relations box provides the

. A @  Under Defined
following options:

Add Relations ~

e Relations. Displays the automatic relations inferenced Ei

during sketching or created manually with the Add — ~
Relations tool. The callout in the Graphics window is Oror construction
highlighted when you select a relation in the dialog box. Parameters A

The Information icon in the Existing Relations box &,
displays the sketch status of the selected sketch entity. &

Example: Under Defined, Fully Defined, etc. %

Add Relations. Provides the ability to add relations to the o2

selected entity. Displays the relations which are possible for
the selected entity.

<> <> <> <>

Options. The Options box provides the following selection:
e For construction. Converts the selected entity to construction geometry.

Parameters. Provides the ability to specify any appropriate combination of
parameters to define the ellipse if the ellipse is not constrained by relations. The
available selections are Center X Coordinate, Center Y Coordinate, Start X
Coordinate (only available for a Partial Ellipse), Start Y Coordinate (only available
for a Partial Ellipse), End X Coordinate (only available for a Partial Ellipse), End Y
Coordinate (only available for a Partial Ellipse), Radius 1, Radius 2 and Angle
(only available for a Partial Ellipse).
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Tutorial: Ellipse 4-1
Create an Ellipse sketch.

1. Create a New L part. Use the
default ANSI Part template.

2. Right-click Front Plane from the
FeatureManager. This is your

Sketch plane.

Design Intent, Sketching and Sketch Entities

Arim OT
TLI;L\. Entities Ent

@
\@ Ellipse
(= Partial Ellipse
U Parabola

ﬂ Conic

3. Click Sketch & from the Context toolbar.
4. Click the Ellipse & Sketch tool. The Ellipse icon is

displayed on the mouse pointer.

5. Click the origin in the Graphics window. This is the start

location.

6. Drag and click to set the major axis of the ellipse. The
ellipse PropertyManager is displayed.

7. Drag and click again to set the minor axis of the

ellipse.

Deselect the sketch tool.

8. Right-click Select in the Graphics window.

Add a vertical geometric relation in the sketch.
9. Hold the Ctrl key down.

10. Click the top vertical point and the bottom

vertical point of the Ellipse.

11. Right-click Make Vertical from the Pop-up menu.

12. View the sketch.
13. Close the model.

Partial Ellipse Sketch Entity

The Partial Ellipse Sketch entity > tool provides the ability
to create a partial ellipse or an elliptical arc from a
centerpoint, a start point, and an end point. You used a
similar procedure when you created a Centerpoint Arc. The
Ellipse PropertyManager controls the properties of a
sketched Ellipse or a Partial Ellipse. View the Ellipse
section for additional information on the Ellipse

PropertyManager.
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Parabola Sketch Entity SEEER

U Parabola @
The Parabola Sketch entity §’ tool provides the ability to create a | ¥
parabolic curve. The Parabola Sketch entity uses the Parabola Existing Relations ~

PropertyManager. The Parabola PropertyManager provides the h
following selections:

e Existing Relations. The Existing Relations box provides the @ Under befined

selected entity. Displays the relations which are possible for A

the selected entity. A

e Options. For construction. Not selected by default. Converts |/~
the selected entity to construction geometry.

following options: “e'““’“s ~
Fix
e Relations. Displays the automatic relations inferenced S ~
during sketching or created manually with the Add [T For construction
Relations tool. The callout in the Graphics window is Parameters ~
highlighted when you select a relation in the dialog box. {3 | A29067287 0
The Information icon in the Existing Relations box [y | 242903797 -
displays the sketch status of the selected sketch entity. n .
Example: Under Defined, Fully Defined, etc. N .
e Add Relations. Provides the ability to add relations to the I8 :

e Parameters. Provides the ability to specify the appropriate
combination of parameters to define the parabola if the
parabola is not constrained by relations. The available
selections are Start X Coordinate, Start Y Coordinate, End
X Coordinate, End Y Coordinate, Center X Coordinate,
Center Y Coordinate, Apex X Coordinate and Apex Y

Coordinate.
Tutorial: Parabola 4-1 @ %A et
Create a Parabola sketch. () Ellipse
1. Create a New [ part. Use the default ANSI, IPS Part (= Partial Ellipse
template. “Na/ Parabola
2. Right-click Front Plane from the FeatureManager. This is N\ Conic
your Sketch plane.

3. Click Sketch E from the Context toolbar.

Apply the Parabola Sketch tool.

4. Click the Parabola \/ Sketch tool from the Consolidated
Sketch toolbar. The Parabola icon is displayed on the mouse
pointer.
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5. Click a position in the Graphics window to locate the
focus of your parabola.

6. Drag to enlarge the parabola. The parabola is outlined.

7. Click on the parabola and drag to define the extent of
the curve. The Parabola PropertyManager is displayed.

8. Click OK ¥ from the Parabola PropertyManager.

9. Rebuild @ the model.
10. Close the model.

. . SER S @ S ERES @
Conic Sketch Entity 1\ conte ® fcm -
v v
The Conic Sketch entity » tool provides the |ostions ~| [existing Retations ~
ability to sketch conic curves driven by g;‘l’;‘i:?;:::” b
endpoints and Rho value. Depending on the

Rho value, the curve can be elliptical, parabolic, or hyperbolic. In ® Under Defined

previous versions of the SOLIDWORKS software, you could T ~
sketch ellipses and parabolas. However, you could not sketch X Fix

ellipses or parabolas by their endpoints, so it was difficult to make [ouon A
them tangent to existing geometry. OJFor construction

Parameters v

Conic curves can reference existing sketch or model geometry, or
they can be standalone entities. You can dimension the curve with
a driving dimension, and the resulting dimension displays the Rho
value. The conic entity also includes a value for the radius of curvature.

Po.32
po.32

Conic curve sketch that references existing geometry Preview of revolved sketch

Finished model

w s

“¥" Auto Tangency accelerates the process of sketching a conic curve.

When you select this option in the Conic PropertyManager, you set the first and second
endpoints for the conic curve. The Conic tool applies tangent relations at each endpoint
of the curve and selects the top vertex of the curve. This option is helpful when you
reference existing geometry. If you clear this option, you must define the top vertex of
the curve.
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The Conic Sketch entity uses the Conic PropertyManager. The
Conic PropertyManager provides the following selections:

o Existing Relations. The Existing Relations box provides the
following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for
the selected entity.

e Options. The Options box provides the following selection:

e For construction. Not selected by default. Converts the
selected entity to construction geometry.

e Parameters. Provides the ability to specify the appropriate
combination of parameters to define the parabola if the
parabola is not constrained by relations. The available
selections are Start X Coordinate, Start Y Coordinate, End
X Coordinate, End Y Coordinate, Center X Coordinate,
Center Y Coordinate, Apex X Coordinate and Apex Y
Coordinate.

Tutorial: Conic 4-1

Create a Conic sketch.

1. Open Conic 4-1 from the
SOLIDWORKS 2017 folder. The model
contains an arc and spline.

Apply the Conic Sketch tool.

2. Click the Conic N Sketch tool from the
Consolidated Sketch toolbar. The Conic
icon is displayed on the mouse pointer. =

3. Click the first endpoint for the conic
curve as illustrated.

Origin
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4. Drag the pointer to the right so it’s tangent
with the arc. Because the endpoint is attached ﬁ___,.__!__.l___
to the existing arc sketch, a yellow inferencing = SN
line is displayed.

5. Click the second endpoint as illustrated.

6. Drag the mouse pointer upwards. A yellow
inferencing line is displayed tangent to the t
spline sketch.

7. Drag the mouse pointer out to the intersection
of the two yellow inferencing lines. You can
snap to the intersection of both inference lines
to choose the top vertex of the conic curve.

8. Click at the intersection of both inferencing — R
lines to set the top vertex of the conic curve. A
By selecting the intersection of both
inferencing lines, you ensure that the conic
curve is tangent at both endpoints.

9. Drag the pointer to the left until the Rho l
value is 0.75. As you move the pointer, the
conic curve's Rho value changes.

10. Click to set the Rho value to 0.75. Reference
points are displayed for the curve's shoulder
and top vertex. Tangent relations are created
between the curve and the original sketches.

11. Click OK ¢ from the Conic
PropertyManager.

12. Rebuild 8 the model.
13. Close the model.

Conic surfaces are very useful for precision
flowing (aerodynamic) shapes. It is best to have
no more than one singular point on a surface. The
midline curve is usually shared by the top and
bottom fuselage shape surfaces.

Rho is the squareness for conic, and translates into

the squareness of the surface. In theory at 1.0 itis a
dead sharp corner, 0.8 is a very modern squarish
corner, 0.6 is most useful for airplane fuselages, 0.4
looks like an ellipse, and 0.1 is a slanted ellipse section
that tends toward a line between the end points.
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Spline Sketch Entity

The Spline Sketch entity » tool provides the ability to create a
profile that utilizes a complex curve. This complex curve is called
a Spline (Non-uniform Rational B-Spline or NURB).

Create a spline with control points. With spline control points, you
can:

e Use spline points as handles to pull the spline into the shape
you want.

e Add dimensions between spline points or between spline
points and other entities.

e Add relations to spline points.

The 2D Spline PropertyManager provides the following selections:

o Existing Relations. The Existing Relations box provides the
following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for
the selected entity.

e Options. The Options box provides the following selection:

e For construction. Not selected by default. Converts the
selected entity to construction geometry.

e Show Curvature. Not selected by default. Provides the
ability to control the Scale and Density of the curvature.
Displays the Curvature of the spline in the Graphics
window.
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Maintain Internal Continuity. Selected by default. Maintains the spline's
internal curvature. When Maintain Internal Continuity is cleared, the curvature
scales down abruptly.

Raised degree. Available only with splines that include curvature handles at each
end. Raises or lowers the degree of the spline. You can also adjust the degrees by
dragging the handles.

Raised degree

Parameters. Provides the ability to specify the appropriate combination of

parameters. The available parameters are:

Spline Point Number. Highlights your selected spline point in the Graphics
window.

X Coordinate. Specifies the x coordinate of your spline point.
Y Coordinate. Specifies the y coordinate of your spline point.

Radius of Curvature. Controls the radius of curvature at any spline point. This
option is only displayed if you select the Add Curvature Control option from the
Spline toolbar, and add a curvature pointer to the spline.

Curvature. Displays the degree of curvature at the point where the curvature
control was added. This option is only displayed if you add a curvature pointer to
the spline.

Tangent Weightingl. Controls the left tangency vector by modifying the spline’s
curvature at the spline point.

Tangent Weighting 2. Controls the right tangency vector by modifying the
spline’s curvature at the spline point.

Tangent Radial Direction. Controls the tangency direction by modifying the
spline’s angle of inclination relative to the X, Y or Z axis.
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Tangent Polar Direction. Controls the elevation angle of the tangent vector with
respect to a plane placed at a point perpendicular to a spline point. This is only for
the 3D Spline PropertyManager.

Tangent Driving. Enables spline control by using the Tangent Magnitude option
and the Tangent Radial Direction option.

Reset This Handle. Returns the selected spline handle to the initial state.

e Reset All Handles. Returns the spline handles to their initial state.

e Relax Spline. Sketch your spline and display the control polygon. You can drag
any node on the control polygon to change shape. If the node you are dragging
results in a spline which is not smooth, re-select the spline to display the
PropertyManager. Click the Relax Spline selection under the Parameters option.
This will re-parameterize or smooth the shape of your spline.

e Proportional. Retains the spline shape when you drag the spline.

Spline toolbar

Use the tools located on the Spline toolbar to control
properties of a sketched spline. The Spline toolbar
provides the following tools:

¥
e Add Tangency Control. The Add Tangency Control tool 7 adds a
tangency control handle. Drag the control handle along the spline
and position it to control the tangency at the selected point.

Spline Tools

*r?sffm_sw

e Add Curvature Control. The Add Curvature Control tool 0 adds
a curvature control handle. Drag the control handle along the spline
and position the control handle to control the spline shape at the

selected point.

e Insert Spline Point. The Insert Spline Point tool r adds a point to

the spline. Drag spline points to reshape the spline.

w1
Eria

You can insert dimensions between the spline points.

o Simplify Spline. The Simplify Spline tool 7 reduces the number
of points in the spline. This function improves the performance in

the model for complex spline curves.

e Fit Spline. The Fit Spline tool - adds a spline based on the

selected sketch entities and edges.
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e Show Spline Handles. The Show Spline Handles tool el displays all handles of the
selected spline in the Graphic window. Use the spline handles to reshape the spline.

e Show Inflection Points. The Show Inflection Points tool R displays all points where
the concavity of a selected spline changes.

e Show Minimum Radius. The Show Minimum Radius tool ) displays the
measurement of the smallest radius in the selected spline.

o Show Curvature Combs. The Show Curvature Combs tool & displays the scalable
curvature combs which visually enhance the curves of your selected spline.

Tutorial: 2D Spline 4-1

Create a 2D Spline sketch. m H* O

1. Create a New L part. Use the default ANSI, IPS Part \'“‘{U Spline .
template. AF Style Spline

2. Right-click Right Plane from the FeatureManager. | & Equation Driven Curve

This is your Sketch plane.

3. Click Sketch £ from the Context toolbar.

Apply the Spline Sketch tool.
4. Click the Spline [V Sketch tool. The spline icon is
displayed on the mouse pointer.

5. Create the Spline. This is an open profile. Create a
seven point control spline as illustrated. Do not
select the origin. The Spline PropertyManager is
displayed.

6. Right-click Select on the last control point.
7. Exit the Spline [V tool. l_

8. Click and drag the spline from left to right. Do not
select a control or handle. The spline moves without
changing its shape. <

9. Click OK ¥ from the Spline PropertyManager.

10. Rebuild ® the model. View the results.
11. Close the model.

Page 4 - 43



Design Intent, Sketching and Sketch Entities SOLIDWORKS® 2017 Reference Guide

AR Spline handles are displayed by default. To hide or display spline handles, click the

Show Spline Handles el tool from the Spline toolbar or click Tools > Spline Tools >
Show Spline Handles.

Tutorial: 2D Spline 4-2

Dimension a 2D Spline sketch handle.
1. Open 2D Spline 4-2 from the
SOLIDWORKS 2017 folder.

2. Edit Sketchl.

Use the Smart Dimension tool to
dimension a spline handle. Display the
handles.

3. Click the Spline in the Graphics
window. The Spline
PropertyManager is displayed.
Locate the pointer on the top

handle. The rotate & icon is displayed.
4. Click the top handle tip.

5. Rotate the handle upwards as illustrated to create a Tangent
Driving.
6. Right-click Smart

Dimension L from the
Context toolbar.

Create a Tangent Radial
dimension. o ”
7. Click the handle arrow tip. “q - l T
D1€ Angle
8. Click the horizontal line. “obes I =

9. Enter 40deg.

10. Set precision to none. u "

11. Click OK ¥ from the
Dimension PropertyManager.

View the results. Tolerance/Precision ~
12. Close the model. 4, [none 7]
Wl “-’@%? [.]_2 {Document) V]

‘¥ Fora Tangent Magnitude, select the arrow tip on the handle
to add the dimension.

V¥ Tllustrations may vary depending on your SOLIDWORKS
version and system setup.
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Tutorial: 3D Spline 4-1
Create a 3D Spline Sketch.

1. Create a New L] part. Use the default ANSI Part

template.
2. Click Insert » 3D Sketch from the Menu bar menu. — L
Apply the Spline Sketch tool. m

3. Click the Spline /V Sketch tool.

4. Click a location in the Graphics window to

place the first spline point. Each time you

click a different location, the space handle

is displayed to help you sketch on a

different plane. IR
ey Y e
v

‘¥ Press the Tab key to change planes in a
3D Sketch.

5. Click three additional locations as

illustrated. The Spline PropertyManager is

displayed.
6. Right-click Select on the last control point. L
7. Exit the 3D Sketch. 3DSketchl is created /

and displayed in the FeatureManager. First point
8. Close the sketch.

Last point
Tutorial: 3D Spline 4-2
Edit a 3D spline sketch using the current elements.
1. Open 3D Spline 4-2 from the SOLIDWORKS
2017 folder.
2. Edit 3DSketchl.
3. Click the Spline in the Graphics window. The / ¥

Spline PropertyManager is displayed.

Modify the Spline shape using the click and drag

method on a control point.

4. Click a spline control point as illustrated and
drag it upward. The Point PropertyManager is
displayed. View the results.
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Modify the Spline shape using the x-, y- and

z- coordinates method on a control point.

5. Click a spline point as illustrated. The Point
PropertyManager is displayed.

6. Set values for x-, y-, and z- coordinates from
the Point PropertyManager. You modified the
shape of the spline. L

Modify the Spline shape using the click and drag

method on a handle. Parameters

7. Click a spline handle as illustrated. 200 A

8. Drag the selected spline handle to control the .x 2000 :
tangency vector by modifying the spline’s L i
degree of curvature at the spline point. The o, 500] 1

Spline PropertyManager is displayed.

Reset the handle to the original location.
9. Click the Reset This Handle option. All values

relative to the selected handle return to their ; *f
%—b
I

original value.

Move the spline.
10. Click and drag the spline from left to right. Do
not select a control point. As the spline is

moved, it retains its shape. [¥]Tangent Driving
. |
11. Click OK % from the Spline
PropertyManager.

Relax Spline

12. Exit the 3D Sketch. View the results.
13. Close the model.

Proportional

Tutorial: 3D Spline 4-3

Add new elements to a 3D Spline.
1. Open 3D Spline 4-3 from the

~
SOLIDWORKS 2017 folder.
2. Edit 3DSketchl.
. Click the spline from the Graphics
window. The Spline PropertyManager is L.
displayed.
3
4. Click the Add Tangency Control fy tool Spline Tools
from the Spline toolbar. ?6 B A gﬂ
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5. Drag to place the handle as illustrated.
6. Click a position for the handle.

7. Click OK ¥ from the Spline

PropertyManager.
8. Exit the 3D Sketch. View the results.
9. Close the model. L
=
Style Spline

The Style Spline § tool provides the ability
to sketch single-span Bézier curves. These curves e
let you create smooth and robust surfaces and are - '
available in 2D and 3D sketches.

The Style Spline consists of only one span. You
shape its curvature by selecting and dragging
control vertex points. Sketch entities connect the
control vertices which form the control polygon
of the curve.

With the Style Spline tool, you can control the degree and
continuity of the curves. You can inference style splines
for tangency or equal curvature. You can constrain the
points and dimension the curves' sides. These curves also
support mirroring and self-symmetry.

Spline on Surface Entity

The Spline on Surface entity @ tool provides the
ability to sketch splines on various surfaces.
Splines sketched on surfaces include standard
spline attributes, as well as the capabilities to add
and drag points along the surface and to generate a
preview that is automatically smoothed through the
points.

i

Al spline points are bounded to the surface on
which they are sketched.
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Tutorial: Spline on Surface 4-1

Create a Closed Spline on Surface feature. vl ©
1. Open Spline on Surface 4-1 from the &> Spline on Surface
SOLIDWORKS 2017 folder. - .

2. Click the top left face as illustrated.

3. Click the Spline on Surface © Sketch tool. The
spline icon is displayed on the mouse pointer.

4. Create a five point closed spline as illustrated.

5. Click OK ¥ from Spline PropertyManager to
close the sketch tool.

6. Click the Extruded Boss/Base Features tool. The
Boss-Extrude PropertyManager is displayed.

7. Click the left vertical line as illustrated for
Direction 1. Edge<1> is displayed in the
Direction of Extrusion box.

8. Enter 10mm for Depth. | :
) % EH _Extrude—Thlnl
9. Click OK ¥ from the Boss- &) Boss-Extrude [0
Extrude PropertyManager. v x®
Boss-Extrudel is displayed. View  |from 2
the results in the Graphics window. |
10. Close the model. . M
Edge <1>
Splines on surfaces can: I-
‘10 Oq Depth (Enter a value or sj
e Span multiple faces. roe resul
e Update if model geometry is Draftoutward
updated (unless the splines are L] Dirction v
constrained) e S ElRCI® >
' 7
L] You can move the pOlntS on the % Spline on Surface 4-1 (Default<<Dej

. . =
spline to different faces by ' “'“"'y
(%] Sensors

dragging the points but not by + [ Amotaions
dragging the curve itself. -
S8 Material <not specified>
ﬂj Front Plane
ﬂ Top Plane
ﬂj Right Plane
I_. Origin
v @ExtrudefThim
[Sketcm

X @ Boss-Extrude1
p, Mot |

(30 () 3DSketch1
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Intelligence Modeling - Equation Driven [§ EE[¢[@]

Curve % Equation Driven Curve @
v X

The Equation Driven Curve hft tool is a 2D Sketch spline driven  |Message ~

Enter an equation in terms of x where

by an equation. This Sketch entity provides the ability to create @ |yne resuiting y values are calculated
curve by specifying the equations that define the curve. aczord:ng o the start value x1 and the
Equations defining a curve specify y- as a function of x-. You e

can use any function that is supported in the Equations dialog Eq"“g‘;‘:;it ”
box. See Chapter 18 - Intelligence modeling techniques for O Parametric
additional information. Caromtors .

Equation

The Equation Driven Curve entity uses the Equation Driven
Curve PropertyManager. The PropertyManager provides the
following selections:

¥x

Parameters

X &
e Equation Type. There are equation types available: Explicit » :
and Parametric. :

e Parameters. The Parameters box provides the following
options:

e Equation. Provides the ability to enter an equation as a
function of X-. If you enter an equation that can’t be
resolved, the text color is displayed in red.

e Parameters. Provides the ability to enter the start and
end X value of the equation.

e Transform. Provides the ability to enter the translation
of X-, Y- and angle for the curve.

% Be & >

Tutorial: Equation Driven Curve 4-1 T
Create an Equation Driven Curve on the Front Plane. ® 5 Paiissbemmie peay
1. Create a New L] part. Use the default ANSI, IPS Part S:::S

template . 4 Annotations
Create a 2D Sketch on the Front Plane. o :"a“""s
2. Right-click Front Plane from the FeatureManager. - Hru@ £

' ront Plane)

3. Click Sketch C_ from the Context toolbar. The Sketch g :{i o 3D Sketch On Plane

toolbar is displayed. Front Plane is your Sketch plane. Lo Cectonvew

4. Click the Equation Driven Curve % Sketch tool. The Wl % © C

Equation Driven Curve PropertyManager is displayed. This L U Botine
tool provides the ability to build intelligences into a part. A Stie spline

.% Equation Driven Curve
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Sfpemfy the equation that defines the sketch. Note: y- is a function D ERC @
of X . . o . Yk Equation Driven Curve ®@
5. Click Explicit for Equation Type.  x
6. Enter 3*x*sin(x) as illustrated in the Equation Message o
box. n Enter an equation in terms of x where
the resulting y values are calculated
7. Enter 0 for the start point as illustrated. according o the start value x1 and the
8. Enter 4*pi for the end point. Note: You can fix Equatig)rw ~
the end points of the curve by applying the Fix P Bxplicit
tOOl. O Parametric
Parameters ~
9. Click OK ¥ from Equation Driven Curve Fquation _
PropertyManager. View the created curve. Yu |0 |
Note: click the curve in the Graphics window to Parameters
edit the Parameters of the curve. H X
, | 4
10. Click Exit Sketch. View the results. i

11. Close the model.

w s

“¥" Use regular mathematical notation and order of operations to write an equation. x;
and x: are for the beginning and end of the curve. Use the transform options at the bottom
of the PropertyManager to move the entire curve in x-, y- or rotation. To specify x=f(y)
instead of y = f(x), use a 90 degree transform.

w1

‘¥ View the .mp4 provided movies in the book to better understand the potential of the
Equation Driven Curve tool. The first one is Calculating Area of a region bounded by
two curves (secx)”2 and sin x in SOLIDWORKS; the second one is Determine the
Volume of a Function Revolved Around the x Axis in SOLIDWORKS. Both are located in
the SOLIDWORKS 2017 folder.

. & L
Curve Through XYZ Points q
. . @ll Project Curve
The Curve Through XYZ Points S feature provides the R T
ability to either type in (using the Curve File dialog box) \‘g Euwe I:roua:::l Poimsp N
or click Browse and import a text file using x-, y-, z- SR

coordinates for points on a curve.

A text file can be generated by any program which

creates columns of numbers. The Curve [ feature
reacts like a default spline that is fully defined. : : :

CnuAe pijs
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Create a curve using the Curve Through XYZ Points tool. Import the x-, y-, z- data.
Verify that the first and last points in the curve file are the same for a closed profile.

w1

A It is highly recommend that you insert a few extra points on either end of the curve
to set end conditions or tangency in the Curve File dialog box.

Imported files can have an extension of either *.sldcrv or *.text.
The imported data x-, y-, z-, must be separated by a space, a comma, or a tab.

Tutorial: Curve Through XYZ points 4-1

Create a curve using the Curve Through XYZ Points tool. Import x-, y-, z- data from a CAM
program. Verify that the first and last points in the curve file are the same for a closed profile.
1. Open Curve Through XYZ points 4-1 from the SOLIDWORKS 2017 folder.

2. Click the Curve Through XYZ Points S tool from the U o
Features CommandManager. The Curve File dialog box is Curves| | jtant3D
displayed.
- I3
Import x-, y-, z- data. Verify that the first and last points in the \j\bﬂ Curve Through XYZ Points
curve file are the same for a closed profile. [ = Helix and Spiral

3. Click Browse from the Curve File dialog box.

4

iCunres (~sldcrv) I

. Browse tO the SOLIDWORKS 2017 fOlder. Curves (*sldcrv)

4
5. Set file type to Text Files.
6

. Double-click cam2.text. View the data in the Curve File : ;’JSOOLBO"
dialog box. View the sketch in the Graphics window. En

Review the data points in the dialog box. 7 3

7. Click OK from the Curve File dialog box.
Curvel is displayed in the FeatureManager.
This curve can now be used in a sketch (fully
defined profile). View the results of the fully

defined sketch using the curve. Point N v N E
1 50mm omm {E e
8. Close the model. 2| sooomm| s E
9. Open Curve Through XYZ points 4}-2 from L somm, 2o8mm : —
the SOLIDWORKS 2017 folder to view the 6 | 2082mm|  45amm c ettt
final model and FeatureManager. e :
10. Close the model. TR

w1

¥ See Chapter 18 - Intelligence Modeling
techniques for additional information.
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Curve Through Reference Points T -
Curves | comiap
The Curve Through Reference Points B (o0l provides
the ability to create a curve through points located on @D" Spit Line
one or more planes. See SOLIDWORKS Help for
additional information. @ Project Curve
R1 Composite Curve
\ U Curve Through XYZ Points
ﬁ Curve Through Reference Points
B Helix and Spiral

Point Sketch Entity

The Point Sketch entity tool provides the ability to insert points
in your sketches and drawings. To modify the properties of a

point, select the point in an active sketch, and edit the properties
in the Point PropertyManager. The Point PropertyManager
provides the following selections:

S ERIS@

= Point @
v
Existing Relations ~
i

@  Under Defined

o Existing Relations. The Existing Relations box provides the
following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is

Add Relations ~
Fix
Parameters A

°ox | 7169384317
ey | 017507926

< > <>

highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for
the selected entity.
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Parameters. Provides the ability to specify the appropriate combination of parameters
for your point only if the point is not constrained by relations. These are the available

parameters:

X Coordinate. Specifies the x coordinate of your point.

Y Coordinate. Specifies the y coordinate of your point.

Centerline Sketch Entity S ERGe
/ Insert Line ®

The Centerline Sketch entity > tool provides the ability to use v x
centerlines to create symmetrical sketch elements and revolved Message A
features, or as construction geometry. The Centerline sketch Edit the settings of the next new line
entity uses the Insert Line PropertyManager. The Insert Line e e
PropertyManager provides the following selections: °'ie"gi:: rorchog ”
e Orientation. The Orientation box provides the following @ e

options: O vertica

O Angle
e As sketched. Sketch a line in any direction using the click |options A
and drag method. Using the click-click method, the As For construction

1

Ly |
-

AT

|:| Infinite length
D Midpoint line

sketched option provides the ability to sketch a line in any

direction, and to continue sketching other lines in any
direction, until you double-click to end your process.

Horizontal. Sketch a horizontal line until you release
your mouse pointer.

Vertical. Sketch a vertical line until you release your
mouse pointer.

Angle. Sketch a line at an angle until you release your
mouse pointer.

The angle is created relative to the horizontal.

Options. The Options box provides two line types:

-
Y

For construction. Selected by default. Converts the selected sketch entity to
construction geometry.

Infinite length. Not selected by default. Creates a line of infinite length which
you can later trim in the design process.

Midpoint line. Creates a line that is symmetrical from the midpoint of the line.

Use Construction geometry to assist in creating your sketch entities and geometry

that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a
centerline.
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Text Sketch Entity S ERG®

A Sketch Text @
The Text Sketch A entity tool provides the ability to sketch text .
on the face of a part and extrude or cut the text. Text can be Qurves -
inserted on any set of continuous curves or edges. This includes J
circles or profiles which consist of lines, arcs or splines. ot i ~

w1
“¥* Convert the sketch entities to construction geometry if the
curve is a sketch entity, or a set of sketch entities, and your sketch

text is in the same sketch as the curve.

The Text sketch entity uses the Sketch Text PropertyManager. The =
Sketch Text PropertyManager provides the following selections: =

w1 [

e Curves. The Curves box provides the following options: ALY

A | 100%
e Select Edges, Curves Segment. Displays the selected iy
AB 1100%
curves, edges, sketches, or sketch segments. o
Use document font
e Text. The Text box provides the following options: Fant..

e Text. Displays the entered text along the selected entity in
the Graphics window. If you do not select an entity, the text
is displayed horizontally starting at the origin.

e Bold Style. Bold the selected text.
e Italic Style. Italicize the selected text.
e Rotate Style. Rotate the selected text.

e Left Alignment. Justify text to the left. Only available for
text along an edge, curve or sketch segment.

e Center Alignment. Justify text to the center. Only
available for text along an edge, curve or sketch segment.

¢ Right Alignment. Justify text to the right. Only available
for text along an edge, curve or sketch segment.

e Full Justify Alignment. Justify text. Only available for text
along an edge, curve or sketch segment.

e Flip. Provides the ability to flip the text.
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e Flip Vertical direction and back. The Flip Vertical option is only available for

text along an edge, curve or sketch segment.

¢ Flip Horizontal direction and back. The Flip Horizontal option is only available

for text along an edge, curve or sketch segment.

e Width Factor. Provides the ability to widen each of your characters evenly by a
specified percentage. Not available when you select the Use document's font

option.

e Spacing. Provides the ability to modify the spacing between each character by a
specified percentage. Not available when your text is fully justified or when you

select the Use document's font option.

e Use document's font. Selected by default. Provides the ability to clear the initial

font and to choose another font by using the Font option button.

e Font. Provides the ability to choose a font size and style from the Font dialog

box.

Tutorial: Text 4-1
Apply text on a curved part. Use the Sketch Text tool.

1.

2.

Open Text 4-1 from the SOLIDWORKS 2017 folder.
The Lens Cap is displayed in the Graphics window.

Click Front Plane from the FeatureManager.

Apply the Text Sketch tool.

3.

Click the Text A Sketch tool. The Sketch Text
PropertyManager is displayed.

Click inside the Text box.

5. Type SOLIDWORKS. SOLIDWORKS is displayed

horizontally in the Graphics window starting at the origin,
because you do not select an entity.

Click the front edge of Base Extrude. Edge<1> is
displayed in the Curves option box. The SOLIDWORKS
text is displayed on the selected edge.

Uncheck the Use document font box.
Enter 250% in the Spacing box.

Click the Font Button. The Choose Font dialog box is
displayed.

10. Select Arial Black, Regular, Point 14.
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11. Click OK from the Choose Font dialog box.

12. Click OK ¥ from the Sketch Text PropertyManager. Sketch7 is created and is
displayed in the FeatureManager. Zoom in on the created text.

13. Close the model.

w1

“¥* If the curve is a sketch entity, or a set of sketch entities, and the sketch text is in the
same sketch as the curve, convert the sketch entities to construction geometry.

Plane Sketch Entity BERNER)

i Sketch Plane ®@
The Plane Sketch entity tool provides the ability for the user to v X

add Reference entities to a 3D sketch. Why? To facilitate pra— ~
sketching, and to add relations between sketch entities. Once you S e

add the plane, you need to activate it to display its properties and |sefine the sketch plane. Then select the
to create a sketch. The Plane sketch entity uses the Sketch Plane ~ |constraining relations to each reference.

PrOpertyManageI‘. First Reference =
@
The Sketch Plane PropertyManager provides the following I
SeleCtlonS: Second Reference A
o First Reference. Provides the ability to select Reference © I
entities from the FeatureManager or from the Graphics
window. Select the constraining relations to each reference. Third Reference ~
The available relations selection is based on the selected © I
geometry.

e Reference Entities. Displays the selected sketch entity or
plane as the reference to position the 3D Sketch plane.

e Select a relation. Select a relation based on the selected
geometry.

w s

“¥* The available relations are displayed in the Sketch Plane
PropertyManager under the First, Second and Third Reference.

The relations are based on existing geometry.
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e Second Reference. Provides the ability to select Reference entities from the
FeatureManager or from the Graphics window. Select the constraining relations to
each reference. The available relations selection is based on the selected geometry.

¢ Reference Entities. Displays the selected sketch entity or plane as the reference
to position the 3D Sketch plane.

e Select a relation. Selects a relation based on the selected geometry.

o Third Reference. Provides the ability to select Reference entities from the
FeatureManager or from the Graphics window. Select the constraining relations to
each reference. The available relations selection is based on the selected geometry.

¢ Reference Entities. Displays the selected sketch entity or plane as the reference
to position the 3D Sketch plane.

e Select a relation. Selects a relation based on the selected geometry.

w1

‘¥ With existing geometry, add a plane by referencing the entities that are present. Use
any number of references required to achieve the desired results.

Tutorial: Sketch Plane 4-1

Add a 3D Sketch plane. Add a plane using references. Select two corner points of a 3D
sketch. The corner points of the rectangle reference the position of the 3D sketch plane.
1. Open Sketch Plane 4-1 from the SOLIDWORKS 2017 folder.

2. Edit 3DSketchl from the FeatureManager.

3. Click Tools > Sketch Entities > Plane. The Sketch Plane BIEFRER]
PropertyManager is displayed.

il sketch Plane @)
- v x w
“¥* Rename a feature or sketch for Message ~
clarity. Slowly click the feature or sketch G [E[RBTSI@®] > || refeences blones sheted.

. entities, edges, faces or vertices) to
name twice and enter the new name when T define the sketch plane. Then select the
the Old one IS hlghhghted % Sketch Plane 4-1 (Default<<Default constraining relations to each reference.

History First Reference A

Sensors @

4 Annotations

"* .

Equations Second Reference A

=% Material <not specified> 5]

E] Front Plane I

Ej Top Plane

E] Righ 1%« Third Reference A~
~ Orig RS ,e t @

Feature (3DSketch1)
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4. Click the top front corner point of the rectangle as /L
illustrated. Point3 is displayed in the First Reference
box.

5. Click the bottom back corner point of the rectangle.
Point4 is displayed in the Second Reference box.

6. Click OK ¥ from the Sketch Plane V 15

PropertyManager.

7. Rebuild 8 the model. Plane2@3DSketchl is
created and is displayed in the Graphics
window.

8. Close the model.

Route Line Sketch Entity

. . . xplode...[E3 =

The Route Line Sketch entity tool provides the s Se[Ele] m
ability to insert a Route line between faces, circular A o @" Route Line '
edges, straight edges, or planar faces. The Route P

Line Sketch entity is active when you:

Items To Connect

e Create an Explode Line Sketch. @
e Edit an Explode Line Sketch. s
e Seclect the Route Line tool in a 3D sketch. Options

DReverse
The Exploded Line Sketch tool @ is a 3D sketch added to an Alternate Path
Exploded View in an assembly. The explode lines indicate the [¥] Along xvz

relationship between components in the assembly.

The Route Line Sketch entity @” uses the Route Line
PropertyManager. The Route Line PropertyManager provides
the following selections:

e Items To Connect. The Items To Connect box provides the
following option:

e Reference entities. Displays the selected circular edges, faces, straight edges or
planar faces to connect with your created route line.

e Options. The Options box provides the following selections:

e Reverse. Reverses the direction of your route line. A preview arrow is displayed
in the direction of the route line.

e Alternate Path. Displays an alternate possible path for the route line.

e Along XYZ. Creates a path parallel to the X, Y and Z axis directions.
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NN 18
Update Take
Speedpak Snapshot

w1

AR Clear the Along XYZ option to use the shortest
9

route. = R

%2‘1
Bill of  Exploded Explmj}
Materials|  View |Line Sketch

Tutorial: Route Line 4-1

Create an Explode Line sketch using the Route Line K@ Brplode Line ketch
Sketch entlty the :eTart;rllsTﬁiap be:wz:n :XF;‘(’;’(;ZQd
1. Open the Route Line 4-1 assembly from the components

SOLIDWORKS 2017 folder. The assembly is
displayed in an Exploded view.

2. Click the Explode Line Sketch &° tool from the
Assembly toolbar. The Route Line
PropertyManager is displayed.

3. Click the inside face of Cut-Extrudel of Shaft-
Collar<1>. The direction arrow points towards
the back. If required, check the Reverse direction
box. Face<1> @Shaft-Collar-1 is displayed in the
Items To Connect box.

4. Click the inside face of the top hole of
Cut-Extrudel of the Flatbar<1> component.
Face<2>@FIlatbar-1 is displayed in the Items To
Connect box. The arrow points towards the right.

5. Click the inside face of Cut-Extrude5 of
RodClevis<1>. Face<3>@AirCylinder-1is
displayed in the Items To Connect box. The
arrow points towards the back.

6. Click the inside face of the second Cut-
Extrude5 feature of RodClevis<l>.
Face<4>(@ AirCylinder-1 is displayed in the
Items To Connect box.

7. Click the inside face of the top hole of
Cut-Extrudel of the Flatbar<2> component.
Face<2>@Flatbar-2 is displayed in the Items
To Connect box. The arrow points towards
the back.
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8. Click the inside face of Cut-
Extrudel of SHAFT-COLLAR<2>.
The direction arrow points towards
the back. Face<1> @Shaft-Collar<2>
is displayed in the Items To Connect
box.

9. Click OK ¥ from the Route Line
PropertyManager. View the created
Route Line.

10. Click OK ¥ from the
PropertyManager to return to the
FeatureManager.

Fit the model to the Graphics

window. Display an Isometric

view.

11. Press the f key to fit the
model to the Graphics
window.

12. Click Isometric view.
View the results.

13. Close the model.

AR SOLIDWORKS provides
the ability to create a Bill of Materials (BOM) in an
assembly. The BOM is displayed in the Tables folder of
the FeatureManager. You no longer need to create a
drawing to see a BOM. See the Assembly section for
additional information.

SOLIDWORKS® 2017 Reference Guide

IS [6]S]
a7 Route Line ¢
v x

Hems To Connect A

@ Face<1>@Shaft-Collar-1
Face<2>@Flatbar-1
Face<3>@AirCylinder-1/R!
Face<4>@AirCylinder-1/R,

Face<2>@Flatbar-2
Face<1=>@Shaft-Collar-2

Options -~
I:‘ Reverse
[ Alternate Path

[¥] Along xvz

Tutorial: Route Line 4-2

TE R S@

Configurations

Edit an Explode Line Sketch.

1. Open Route Line 4-2 from the SOLIDWORKS 2017 N
folder. The Route Line 4-2 Assembly
FeatureManager is displayed.

2. Click the ConfigurationManager tab.

N @ Route Line 4-2 Configuratiol

v N " Default [ Route Line
» AT Expl |" 4

3. Expand Default.

ﬁxplode

L
Animate explode

x Delete

Comment

4. Right-click ExplView1 from the
ConfigurationManager.

5. Click Explode. View the results in the Graphics
window.

6. Expand ExplViewl.
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Edit the Explode Line Sketch.
7. Right-click 3DExplodel from the

ConfigurationManager. /EE

8. Click Edit Sketch.

9. Display a Top view.

10. Click Centerline < from the Sketch
toolbar. The Insert Line
PropertyManager is displayed. E -

|
|
11. Click the endpoints of the Route Line //L - \

as illustrated.

Create a new path. L
12. Click a point to the right of the Route

Line endpoint and over the top of the

axle. ®
13. Click a point below the axle as

illustrated.
14. Click a point to the left of the axle over the Flatbar. e N = X
15. Click a point below the Flatbar. @2 P R O e
16. Click a point above the SHAFT-COLLAR. B s |
17. Click a point below the Shaft-Collar. A Lo
Deselect the active Sketch tool.
18. Right-click Select in the Graphics window. K4 =l O |
19. Rebuild 9 the model. View the results. - Fgu;ﬁn::r4D:Si:fT:;|aﬁo

< Tj. « Default [ Route Line
< @? ExplView1
21. Close the model. o (-) 3DExplodef
d Explode Step1
|Lr| Explode Step2
d Explode Step3
d Explode Step4
|Lr| Explode Step5
d Explode Step6

20. Return to the FeatureManager design tree.
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Belt/Chain Sketch Entity & ERle[@
Belt/Chain @

This option provides the ability to create layout sketches for v x

pulleys or sprocket mechanisms. The Belt/Chain feature Message ~

simulates a cable-pulley mechanism. The Belt/Chain entity uses |select thecircle orarc to define beit

the Belt/Chain PropertyManager. g;i!‘be” aroundubich he beltwrl

- ] ' Belt Members N

A8 In the past, it was difficult using SOLIDWORKS to &

effectively model components such as cables, chains, and timing
belts due to their flexible motion. The shapes of these items

could change over time. This made it difficult to examine the

way a belt would interact with two or more pulleys, or a cable Flip belt side

system shifts a lever, or crank with a solid assembly model. Properties ~
Belt Length:

The Belt/Chain PropertyManager provides the following Dg B

selections: omm

I:l Use belt thickness
Engage belt

e Belt Members. The Belt Members box provides the
following options:

e Pulley Components. Displays the selected arcs or
circles for the pulley components.

e Up arrow. Moves the selected pulley component
upwards in the displayed order.

e Down arrow. Moves the selected pulley component @®
downward in the displayed order. ‘-;;@ ;L.

e Flip belt side. Changes the side on which the belt is
located in the pulley system. Q

e Properties. The Properties box provides the ability to X
define the following belt conditions:

e Driving. Cleared by default. Provides the ability to

calculate the length of your belt. When checked, enter @
a value if you do not want the system to calculate ’® L
your belt length. Based on the constraints, one or h
more of the components may move to adjust for the O
length of the belt. :
W

e Use belt thickness. Specifies the thickness value of
the belt.

Page 4 - 62



SOLIDWORKS® 2017 Reference Guide Design Intent, Sketching and Sketch Entities

e [Engage belt. Selected by default. Disengages the belt mechanism.

w1
AT

Only circle entities in a block can be selected for a belt member.

Blocks S ER @

&7 Make Block @

Blocks are a grouping of single or multiple sketch entities. In v

SOLIDWORKS, the origin of the block is aligned to the Block Entitles -
orientation of the sketch entity. Previously, blocks inherited their
origin location from the Parent sketch. These are additional = :

Insertion Point kel
enhancements to Blocks: [Jiayout Sketch Block ‘
Drag Manipulator on-screen to
e Modeling pulleys and chain sprockets. position insertion point.

e Modeling cam mechanisms.

Blocks are used in the Belt/Chain sketch entity. You can create blocks from a single or
multiple sketch entities.

Why should you use Blocks? Blocks enable you to:

e Create layout sketches using the minimum of dimensions and sketch relations.
o Freeze a subset of sketch entities in a sketch to control as a single entity.

e Manage complicated sketches.

e Edit all instances of a block simultaneously.

“¥* Use blocks in drawings to conserve drawing items such as standard label positions,
notes, etc. See SOLIDWORKS Help for additional information.

Blocks toolbar Blocks
A e

The Blocks toolbar controls blocks in sketching. The
Blocks toolbar provides the following tools:

e Make Block. The Make Block tool provides the ability to create a new block.

e Edit Block. The Edit Block * tool provides the ability to add or remove sketch
entities and to modify dimensions and relations in your sketch.

o Insert Block. The Insert Block = tool provides the ability to add a new block to
your sketch or drawing. This option provides the ability to either create multiple
instances of existing blocks or to browse for existing blocks.

e Add/Remove. The Add/Remove 2 tool provides the ability to add or remove sketch
entities to or from your block.
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e Rebuild. The Rebuild tool provides the ability to update the parent sketches
affected by your block changes.

e Saves Block. The Saves Block tool provides the ability to save the block to a file.
Adds an .sldblk extension.

e Explode Block. The Explode Block = tool provides the ability to explode the
selected block.

e Belt/Chain. The Belt/Chain & tool provides the ability to insert a belt.

w s

A Exploding a single instance of the block only affects that instance of the block.

Tutorial: Block 4-1
Create a Block using the Blocks toolbar.

1. Create a New L) part. Use the default ANSI Part
template. -

2. Click Top Plane from the FeatureManager. This is your
Sketch plane.

3. Sketch a closed sketch using sketch entities as illustrated.
The sketch consists of five lines.

4. Click Make Block from the Block toolbar or click

Tools > Blocks > Make. The Make Block EM B[;Eka e ®
PropertyManager is displayed. A1 Wiake Bloc
X
5. Box-select the sketch entities from the %Mes ~
Graphics window. The selected sketch Line1
entities are displayed in the Block e
Entities box. AEREDE i
6. Expand the Insertion Point box. Note g _
. . . . % Part1 (Default<<Default>_Dis s
the location of the insertion point. R History \nsertion Point ~
. Senscrs I:‘ ayout Sketch Block
7. Clle OK ﬁ? from the Make BlOCk » Annctations Dra; )I\’Aartizulattorzn—screen to
PropertyManager. Block1-1 is displayed [ Equations position insertion point
in the FeatureManager gﬁ? Material <not specified>
Front Plane
8. Rebuild 9 the model. ) ep e
ﬂ Right Plane
9. Close the model. 1, origin
+ €2 () Sketch1
Block1-1
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w1

“¥* Create a block for a single or combination of multiple
Sketch entities. Saving each block individually provides you
with extensive design flexibility.

Tutorial: Belt-chain 4-1

Use the Belt/Chain Sketch entity function. Create a pulley sketch.

1. Open Belt-chain 4-1 from the SOLIDWORKS 2017 folder.
View the three created blocks in the Belt-chain
FeatureManager.

2. Edit Sketchl from the FeatureManager.

3. Click Tools » Sketch Entities > Belt/Chain. The
Belt/Chain PropertyManager is displayed.

4. Select the three circles from left to right. The select
circles are displayed in the Belt

)
¢

% Belt-chain 4-1 (Default<<Default>_
4 History
Sensors
4 Annotations
Equations

-
8% Material <not specified>

Blo[@ >

m Front Plane
g Top Plane

Members dialog box. CER S @ _ L
el ain @ e O
5. Check the Driving box. v x e O
6. Enter 460mm for Belt Length. Message ~ Q
Select the circle or arc to define belt
7. Check the Use belt thickness box. | <= end e needtsd
8. Enter 20mm for belt thickness. "g T
9. Click OK ¥ from the Belt/Chain
PropertyManager. _ L ®
10. Expand Sketchl. Beltl is created Fipbetside b @
and is displayed in the Properties N
FeatureManager. The calculated Belt LtD“ _
belt length was larger than the belt : N
length entered in the [ Use belt thickness
PropertyManager. The system 2000mm ] = N
moved the entities to correct for e g ERe/@

the entered 460mm belt length.

11. Rebuild 9 the model. View the results.
12. Close the model.

L
ELT N

v View SOLIDWORKS Help for additional information.

The Select Chain command has been enhanced to allow you
to select construction entities. See SOLIDWORKS Help for
additional information.
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4 History
Sensors
4 Annotations
Equations
25 Material <not specified>
Ej Front Plane
Eg Top Plane
Ej Right Plane

I_. Origin
%t () Sketch1
(&)

°| 20MM_Circle-1
40MM_Circle-1
60MM_Circle-1

& Beit1 (Length=32572mm)
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Reuse an existing 2D Sketch

You can use the same sketch to create different features. To create different features with
the same sketch:

e (Create a sketch.
e C(Create a feature from the sketch.

¢ In the FeatureManager design tree, select the same sketch used to create the first
feature.

e C(Create a second feature from the sketch.
In the FeatureManager design tree, a sketch that is shared by multiple features is

identified by the Shared ke, icon or by Shared =2 icon for a selected contour.
w e
* Add additional sketches as required to create the features. For example, if one
feature is an extrude and the other feature is a revolve use the same sketch for both
features, but add a centerline to create the revolve.

Tutorial: Shared Sketch 4-1 BIEEE e

Create an Extrude Thinl feature with a shared sketch. @] Boss-Extrude

1. Open Shared Sketch 4-1 from the SOLIDWORKS 2017 folder. |* * ©

2. Click Sketchl from the FeatureManager. View the sketch in the " A
GraphICS Wll’ldOW. Dlre:tlon 1 A

Mld Plane

3. Click Extruded Boss/Base @] from the Feature toolbar. I

4. Select Mid Plane for End Condition in Direction 1. & [eoomm

5. Enter 16.00mm for Depth. g

6. Check the Thin Feature Draft outward
dlalog bOX_ . Thin Feature

7. Enter 4.50111111 fOI‘ <\ m
TthkneSS ° Selected Contours

8. Click the Reverse ©
Direction button. -

9. Click inside the Selected
Contours dialog box.

10. Click the circumference
of the large circle in the Graphics window.

11. Click OK ¥ from the PropertyManager.
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12. Expand Extrude-Thinl in the
FeatureManager. View the
Shared sketch.

13. Close the model.

I_. Origin
v ajExtrudM
féﬁ Sketch1
N éﬂExtrudefThim
féﬁ Sketch1

Summary

In this chapter, you learned about the available tools to incorporate Design Intent into a
sketch, feature, part, assembly and drawing.

Sketching is the foundation of a model. You addressed 2D and 3D Sketching and how to
recognize various Sketch states: Fully Defined, Over Defined, Under Defined, No
Solution Found and Invalid Solution Found along with identifying the correct Reference
plane.

You reviewed the following Sketch Entities: Line, Corner Rectangle, Center Rectangle,
3 Point Corner Rectangle, 3 Point Center Rectangle, Parallelogram, Straight Slot,
Centerpoint Straight Slot, 3 Point Arc Slot, Centerpoint Arc Slot, Polygon, Circle,
Perimeter Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Conic, Spline, Style Spline, Spline on Surface, Equation Driven Curve, Point,
Centerline, Text, Plane, Route line and Belt/Chain.

You utilized and addressed the following toolbars: Block toolbar and Spline toolbar and
applied the Instant3D tool.

Fully define all sketches in the model. However, there are times when this is not
practical, generally when using the spline tool to create a freeform shape.

Use Construction geometry to assist in creating your sketch entities and geometry that are
ultimately incorporated into the part. Construction geometry is ignored when the sketch is
used to create a feature. Construction geometry uses the same line style as a centerline.

s
i

Press the Tab key to change planes in a 3D Sketch.
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You can transition from sketching a line to sketching a Tangent Arc, and vice versa,
without selecting the Arc tool from the Sketch toolbar. Example: Create a line. Click the
endpoint of the line. Move your mouse pointer away. The Preview displays another line.
Move your mouse pointer back to the selected line endpoint. The Preview displays a
tangent arc. Click to place the arc. Move the mouse pointer away from the arc endpoint.
Perform the same procedure above to continue.

Rename a feature or sketch for clarity. Slowly click the feature or sketch name twice and
enter the new name when the old one is highlighted.

w1
“¥" The plane or face you select for the Base sketch determines the orientation of the
part.

w s

“¥" The PropertyManager remembers its last used state.

Chapter 5 provides a comprehensive understanding of the available Sketch tools,
Geometric relations, Dimensions/Relations tools and the DimXpertManager in
SOLIDWORKS.
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